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특징

이 기기는 금속에 각인을 하는 프린터입니다. 이미지는 헤드에 장착된 마킹 핀을 사용하여 미세한 도트를 
찍어 각인됩니다.

이 기기에 대하여
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본체

전면

No. 이름 기능 개요

커버 안전을 위해, 인쇄하기 전에 반드시 커버를 닫으십시오. 커버를 열거나 
닫을 때는 커버의 중간 부분을 잡으십시오.

헤드 유닛 기기로 전송된 데이터에 따라 헤드 위치를 이동합니다. 각인이 시작
되기 전에 헤드 탭 (마킹 핀)이 소재 표면의 높이에 맞춰집니다.

노브 헤드 캡을 사용하지 않고 각인을 수행할 경우 소재의 표면 높이에 따라 
헤드 위치를 결정합니다.

헤드 (MPH-90) 헤드는 소모성 부품입니다. 적절한 시기에 교체하십시오.

마킹 핀 소재에 텍스트와 이미지를 각인하기 위해 미세한  Dot를 찍습니다. 마
킹핀 끝 부분에 다이아몬드가 부착되어 있습니다.

전원/이동 버튼 누르면 불이 켜지고 전원이 켜집니다. 기기가 켜진 상태에서 누르면 헤
드가 테이블의 중앙 표면(또는 중앙 바이스)으로 이동합니다. 다시 누르
면 헤드가 내부의 좌측으로 이동하고 테이블이 기기의 앞쪽 가장자리로 
돌아갑니다. 전원을 끄려면 버튼을 1초 이상 길게 누릅니다.

각 부의 명칭 및 기능
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측면

No. 이름 기능 개요

전원코드 연결부 제공된 AC 어댑터를 연결합니다.

USB 연결부 제공된 USB 케이블을 연결합니다.

관련된 링크
・ P. 116 헤드 교체

소재 리테이너

접착 시트 이것은 테이블에 소재를 고정하는 데 사용됩니다. 소재는 접착 시트에 놓이
고 소재를 제자리에 고정합니다. 이를 통해 시중에서 판매하는 테이프나 이
와 유사한 것을 사용하지 않고도 물체를 고정할 수 있습니다.

센터 바이스 이것은 플라스틱으로 만든 바이스입니다. 이 바이스는 클램프로 소재를 고정하
여 제자리에 고정합니다. 이를 통해 접착 시트를 사용하여 고정할 수 없는 소재 
(예: 바닥 표면이 고선형인 품목)를 고정할 수 있습니다.
센터 바이스는 클램프 핀과와 동일한 베이스를 사용합니다. 센터 바이스와 클램
프 핀 사이을  각각 활용하여 각인할 소재가 정확하게 고정이 되도록 맞춥니다.

클램프 핀 이것은 플라스틱으로 만든 바이스입니다. 이 바이스는 펜 모양의 소재를 클램핑
하여 제자리에 고정합니다. 바닥 표면이 곡선 형태인 길고 얇은 소재를 고정하
는 데 적합합니다.
클램프 핀은 센터 바이스와 동일한 베이스를 사용합니다. 센터 바이스와 클램프 
핀 사이을  각각 활용하여 각인할 소재가 정확하게 고정이 되도록 맞춥니다.

각 부의 명칭 및 기능
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관련된 링크
・ P. 42 소재 장착

각 부의 명칭 및 기능
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다음 품목은 기기와 함께 제공됩니다. 그들이 모두 존재하고 설명되어 있는지 확인하십시오.

AC 어댑터 (1) 전원 코드 (1) 헤드 캡 (10)*1
센터 바이스 (1) *2

클램프 핀 (2) *2 접착 시트 (1) 테이블 (1) USB 케이블 (1)

헤드 (MPH-90) (1)*3
시험용 각인용 소재(2)

(황동도금판) 육각 렌치 (1) 안전 예방 조치 (1)

빠른 액세스 가이드 (1)

*1 기본적으로 하나는 장치에 설치되어 있습니다.
*2 클램프 핀은 센터 바이스와 동일한 베이스를 사용합니다. 센터 바이스와 클램프 핀 사이을  각각 활용하여 각인할 소재가
      정확하게 고정이 되도록 맞춥니다.

*3 기본적으로 기기에 설치되어 있습니다.

관련된 링크
・ P. 23 기기가 각인할 수 있는 소재

제공된 품목
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설치 환경

양호한 작동 조건을 제공하는 조용하고 안정적인 장소에 설치하십시오. 부적절한 위치는 사고, 화재, 잘못된 
작동 또는 고장을 일으킬 수 있습니다.

수평이고 안정된 위치에 설치하십시오.
그렇지 않으면 기기가 떨어져 부상을 입을 수 있습니다.

주의

설치가 불가능한 환경 및 위치

• 습도와 온도가 크게 변동하는 장소
• 흔들림이나 진동이 있는 장소
• 바닥이 기울어져 있거나 수평이 아니거나 불안정한 장소
• 먼지가 많거나 더러운 장소
• 실외 장소 및 직사광선에 노출된 장소
• 에어컨이나 난방 장비에 가까운 장소
• 강한 전기적 또는 자기적 노이즈나 기타 형태의 전자기 에너지에 노출된 장소
• 실리콘 물질(오일, 그리스, 스프레이 등)이 있는 환경

설치
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리테이너 제거 및 보관

리테이너는 운송 중 진동으로부터 기기를 보호하기 위해 장착됩니다. 설치 후 리테이너를 제거하십시오.

이 작업은 전원 코드를 연결하기 전에 수행해야 합니다.
이러한 작업 중에 실수로 전원이 켜지면 손이 끼이거나 기타 부상을 입을 수 있습니다.

경고

• 모든 리테이너를 제거하십시오. 남아 있는 리테이너는 전원을 켤 때 오작동이나 고장을 일으킬 수 있습니다.

• 리테이너와 패키지는 기기를 다른 위치로 옮길 때 필요합니다. 리테이너를 이 기기의 뒷면에 장착하여 분실되지 않도록 
주의해서 보관하십시오.

IMPORTANT

리테이너 제거

리테이너는 3개의 지점에서 고정되어 있습니다(스크류 5개). 제공된 육각 렌치를 사용하여 모든 스크류와 
리테이너를 제거합니다.

리테이너 보관

리테이너를 다음 그림의 위치에 장착하여 보관하십시오.

설치

설치 및 설정 11



설치

12 설치 및 설정



전원 코드 연결

아직 USB 케이블로 컴퓨터를 기기에 연결하지 마십시오. 연결하면 METAZA Driver를 설치할 수 없게 될 수 있습니다. 
METAZA Driver를 설치할 때 컴퓨터를 기기에 연결하십시오.

IMPORTANT

AC 어댑터에 표시된 정격을 충족하지 않는 전원 공급 장치와 함께 사용하지 마십시오.
다른 전원 공급장치와 함께 사용하면 화재나 감전이 발생할 수 있습니다.

경고

기기와 함께 제공된 것 이외의 AC 어댑터나 전원 코드를 사용하지 마십시오.
다른 전원 공급장치와 함께 사용하면 화재나 감전이 발생할 수 있습니다.

경고

전원 코드, 플러그, 콘센트를 올바르고 조심스럽게 다루십시오. 손상된 제품은 절대 사용하지 마십시오.
손상된 제품을 사용하면 화재나 감전이 발생할 수 있습니다.

경고

연장 코드나 멀티탭을 사용할 때는 기기의 정격(전압, 주파수, 전류)을 충분히 만족하는 것을 사용하십
시오.
하나의 콘센트에 여러 개의 전기 장치를 연결하거나 긴 연장 코드를 사용하면 화재가 발생할 수 있습니다.

경고

케이블 연결
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관련된 링크
・ P. 16 METAZA 드라이버 설치

케이블 연결
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시스템 요구 사항

최신 정보는 Roland DG Corporation 웹 사이트를 참조하십시오.

운영체제 (OS)*1 Windows 11, 10, 8.1 (32-bit 및 64-bit 버전)

프로세서 Intel® Core 2 Duo 이상 (Core i5 이상 권장)

메모리 1 GB 이상 (2 GB 이상 권장)

그래픽 카드와 모니터 최소 16비트 색상(하이 컬러) 및 1024 x 768 이상의 해상도 권장

설치에 필요한 하드 디스크 여유 공간 25 MB

*1 이 소프트웨어는 32비트 애플리케이션이므로 64비트 버전의 Windows에서 WOW64(또는 Windows-On-Windows 64)로 실행됩니다.

관련된 링크

・ https://www.rolanddg.kr/

설치 및 설정할 수 있는 소프트웨어

다음 URL에 액세스하여 소프트웨어를 다운로드하십시오.
• https://downloadcenter.rolanddg.com/MPX-90S

METAZAStudio 각인 데이터를 생성하는 프로그램입니다. 각인할 이미지를 가져오고 자르고 텍스트, 
상자 등을 추가하는 편집을 수행할 수 있습니다.

SFEdit2 이 프로그램을 사용하면 스트로크 문자 글꼴을 만들고 편집할 수 있습니다. 스트로크
문자 글꼴은 트루타입 글꼴에서 중심선을 자동으로 추출하여 만든 라인입니다.
METAZAStudio에서 생성된 스트로크 문자 글꼴을 글꼴로 사용할 수 있습니다.

MPX-90 Head Manager 헤드를 조정하는 유틸리티입니다. 헤드를 교체하거나 마킹 핀을 조정할 때 실행하십시오.

METAZA Driver 이 Windows 드라이버는 컴퓨터에서 기기로 데이터를 전송할 때 필요합니다.

소프트웨어 설치
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METAZA 드라이버 설치

절차에 따라 기기를 컴퓨터에 연결했는지 확인하십시오. 올바른 절차를 따르지 않으면 설치가 불가능할 수 있습니다.

IMPORTANT

절차

본 기기는 MPX-90과 동일한 버전의 METAZA Driver를 사용 가능하므로 [Model]에 "MPX-90"을 선택해 주시기 
바랍니다.

1. 설치 및 설정을 시작하기 전에 USB 케이블이 연결되어 있지 않은지 확인하십시오.

2. [관리자] 권한으로 Windows에 로그온합니다.

3. 다음 URL에 접속하여 METAZA 드라이버를 다운로드하십시오.

https://downloadcenter.rolanddg.com/MPX-90S

4. 다운로드한 파일의 콘텐츠를 임의의 위치에 압축 해제합니다.

5. 압축 해제된 폴더를 열고 "SETUP64.EXE" 또는 "SETUP.EXE"를 더블 클릭합니다.
[Driver Setup] 창이 나타납니다. [사용자 계정 컨트롤] 창이 나타나면 [예]를 클릭합니다.

6. [Install]을 선택하고 아래와 같이 모델명과 포트를 선택한 후 [Start]를 클릭합니다.

• [Model]: MPX-90
• [Port]: USB

             IMPORTANT

설치 프로그램이 나타납니다. 메시지를 따라 소프트웨어를 설치합니다.
설치가 완료되면 설치 프로그램이 자동으로 종료됩니다.

7. USB 케이블을 사용하여 기기를 컴퓨터에 연결하십시오.

소프트웨어 설치
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소프트웨어 설치

절차

1. [관리자] 권한으로 Windows에 로그온합니다.

2. 다음 URL에 액세스하여 소프트웨어를 다운로드하십시오.

https://downloadcenter.rolanddg.com/MPX-90S
다음 세 가지 소프트웨어를 다운로드하십시오.

• METAZAStudio
• SFEdit2
• MPX-90 Head Manager

3. 다운로드한 각 파일의 내용을 임의의 위치에 압축 해제합니다.

4. 압축 해제된 각 폴더를 열고 "setup.exe"를 더블 클릭합니다.

설정창이 나타납니다. [사용자 계정 컨트롤]창이 나타나면 [예]를 클릭합니다.

5. 메시지에 따라 소프트웨어를 설치하십시오.

소프트웨어 설치
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프린터 설정하기

METAZAStudio 설치를 마치면 해당 기기를 각인 데이터의 출력 대상으로 지정하십시오. 사용 전에 설정을 
완료해야 합니다.

절차

1. METAZAStudio를 시작합니다.

• Windows 11
a. [시작]을 클릭합니다.
b. [모든 앱]>[Roland METAZAStudio]>[METAZAStudio]를 클릭합니다.

• Windows 10
a. [시작]을 클릭합니다.
b. [Roland METAZAStudio]>[METAZAStudio]를 클릭합니다.

• Windows 8.1

a. [시작] 화면 좌측 하단에 있는       을 클릭하면 [앱] 화면이 나타납니다.
b. [METAZAStudio]를 클릭합니다.

2. [File]>[Set up the printer]를 클릭합니다.

[프린터 설정] 창이 나타납니다.

3. 프린터 설정을 구성합니다.

(1) [Name] 옆에 있는 화살표를 클릭하고 [Roland MPX-90]을 선택하십시오.

(2) [OK]를 클릭합니다.

 METAZAStudio 설정
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각인 영역

METAZA Driver에서 최대 각인 가능 영역(①)을 설정합니다. 이미지가 권장 각인 영역을 초과하면 각인 결과
가 고르지 않을 수 있습니다.

그리드 라인은 5 mm (0.2 in.) 간격으로 테이블에 그려집니다. 이 그리드를 각인할 개체를 정렬할 때 가이드
라인으로 사용합니다.

최대 각인 가능 영역 80 mm × 80 mm (3.14 in. × 3.14 in.)

추천 각인 영역 50 mm × 50 mm (1.97 in. × 1.97 in.)

A 중심선 -

기본 조작
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헤드 캡

헤드 캡을 사용하면 각인 중에 헤드가 자동으로 위아래로 움직여 각인 표면의 높이와 일치합니다. 이 방법은 
각인 표면으로부터 일정한 거리를 유지하여 각인 품질의 변화를 최소화합니다. 일반적인 각인에는 헤드 캡
을 사용하는 것이 좋습니다.
헤드 캡은 곡면에 각인하는 데도 적합하지만 각인 가능한 영역은 일반적인 경우보다 작습니다.

손상되기 쉬운 소재의 경우 헤드 캡을 사용하지 않고 각인합니다. 높이 위치를 설정하고 헤드 캡을 제거한 다음 각인을 
수행합니다.

MEMO

각인 표면의 먼지등 이물질을 제거합니다.

각인할 표면에 오염된 먼지 및 이물질을 제거하지 않고 각인을 수행하면 각인 품질이 저하될 수 있습니
다. 각인을 수행하기 전에 각인할 소재의 표면에서 먼지 및 이물질을 제거해야 합니다.

테스트 각인의 경우 긁힘이나 얼룩이 없는 소재를 사용하는 것이 좋습니다.

각인하기 전에 소재와 헤드 캡에 (①) 긁힘이나 얼룩이 없는지 확인하십시오. 긁힘이나 얼룩이 있는 상태
에서 각인하면 각인 품질이 떨어질 수 있습니다.

실제 각인을 수행하기 전에 테스트 각인을 수행하는 것이 좋습니다.

관련된 링크
・ P. 91 굴곡진 표면에 각인
・ P. 115 헤드 캡 교체 주기

기본 조작
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기기가 각인할 수 있는 소재

다음 조건을 모두 충족하는 소재를 준비합니다.

두께

• 0.3 mm - 40 mm (0.02 in. - 1.57 in.)

크기

• 접착 시트를 사용 시 (폭×길이)
100 mm × 200 mm (3.93 in. × 7.87 in.) 이하

• 센터 바이스를 사용 시 (폭×길이)
60 mm × 200 mm (2.36 in. × 7.87 in.) 이하

• 클램프 핀을 사용 시 (폭×길이)
45 mm × 200 mm (1.77 in. × 7.87 in.) 이하

센터 바이스나 클램프 핀을 사용할 경우, 소재를 장착하는 방향은 소재의 크기와 의도한 각인 영역에 따라 
제한될 수 있습니다.

두께와 크기가 위에 명시된 범위 내에 있더라도 각인 중에 휘는 소재는 사용할 수 없습니다. 휘어진 소재는 헤드를 때려 
소재와 마킹 핀을 손상시킬 수 있습니다.
다음 표는 구성에 따른 각인 가능한 두께와 크기를 보여줍니다.

IMPORTANT

소재 두께 폭 × 길이 (일반 가이드)

알루미늄 2.0 mm (0.08 in.) 60 mm (2.4 in.) 이하의 폭 (또는 너비)

1.5 mm (0.06 in.) 40 mm (1.6 in.) 이하의 폭 (또는 너비)

1.0 mm (0.04 in.) 30 mm (1.2 in.) 이하의 폭 (또는 너비)

0.5 mm (0.02 in.) 20 mm (0.8 in.) 이하의 폭 (또는 너비)

0.3 mm (0.01 in.) 20 mm (0.8 in.) 이하의 폭 (또는 너비)

황동 또는 구리 2.0 mm (0.08 in.) 60 mm (2.4 in.) 이하의 폭 (또는 너비)

1.5 mm (0.06 in.) 40 mm (1.6 in.) 이하의 폭 (또는 너비)

1.0 mm (0.04 in.) 30 mm (1.2 in.) 이하의 폭 (또는 너비)

0.5 mm (0.02 in.) 15 mm (0.6 in.) 이하의 폭 (또는 너비)

0.3 mm (0.01 in.) 15 mm (0.6 in.) 이하의 폭 (또는 너비)

스테인리스 스틸 2.0 mm (0.08 in.) 60 mm (2.4 in.) 이하의 폭 (또는 너비)

1.0 mm (0.04 in.) 40 mm (1.6 in.) 이하의 폭 (또는 너비)

각인 표면의 경도

• 비커스 경도 (HV) 200 이하

기본 조작
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각인으로 인해 균열이나 쪼개질 수 있는 소재(예: 유리, 돌, 보석, 도자기, 도자기 등)는 경도가 이전 범
위 내에 있어도 각인할 수 없습니다. 이러한 소재를 각인하려고 하면 기기가 손상될 수 있습니다.
소재 표면의 경도에 대한 정보는 소재를 구입한 매장이나 소재 제조업체에 문의하십시오.

각인할 소재의 단면

• 각인 표면에는 고르지 않은 부분이 없어야 합니다.
장착 중이나 각인 중에 기기의 움직이는 부분과 접촉하는 소재는 사용할 수 없습니다.

다음과 같은 유형의 소재는 사용할 수 없습니다.

모서리가 높은 소재 L자형 소재

MEMO

접착시트를 사용하는 경우
뒷면은 평평해야 하며, 수평 차이가 없어야 합니다.

다음과 같은 유형의 소재는 사용할 수 없습니다.

곡선형 바닥 표면이 있는 소재

MEMO

헤드 캡 없이 사용하는 경우
각인면은 평면이어야 합니다.

MEMO

기본 조작

다음과 같은 유형의 소재는 사용할 수 없습니다. 

24 각인하기
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각인면이 비스듬한 소재

곡면을 각인할 때 소재의 조건
다음 표는 실린더 직경에 대한 권장 각인 영역과 마킹 핀이 도달한 영역을 보여줍니다. 다음 조건이 충족
된다고 가정합니다.

곡면에 각인하는 경우, 소재의 모양이나 구성에 관계없이 사진 데이터의 이미지 품질을 보장할 수 없습니다.

• 헤드 캡을 사용합니다.
• 소재에 곡면이 있습니다.

     IMPORTANT

원통형 재료의 직경 권장 각인 영역 (A) 마킹 핀(B)이 도달하는 영역

10 mm (0.4 in.) 2.0 mm (0.08 in.) 2.8 mm (0.11in.)

20 mm (0.8 in.) 2.8 mm (0.11in.) 4.0 mm (0.16 in.)

30 mm (1.2 in.) 3.4 mm (0.14 in.) 4.8 mm (0.19 in.)

0.1 mm (3.7 in.)

0.2 mm (3.7 in.)

관련된 링크

기본 조작
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・ P. 42 소재 장착

기본 조작
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전원 켜기

절차

1. 커버를 엽니다.

커버를 열 때 커버의 가운데 부분을 잡으십시오.

2.    노브(①)를 약 한 바퀴 돌려서 헤드 스토퍼(②)를 느슨하게 합니다.

3. 커버를 닫습니다.

4. 전원/이동 버튼을 누르릅니다.
헤드가 왼쪽 뒤쪽 모서리로 이동하고 전원/이동 버튼의 램프가 점등되기 전에 점멸합니다. 이 작업을 
초기 동작이라고 합니다.

전원 켜기 및 끄기

각인하기 27



전원을 켠 후에도 전원 램프가 계속 점멸하면 헤드의 스토퍼가 너무 조여져 초기 동작 오류가 발생한 것입니다. 
스토퍼를 풀고 전원/이동 버튼을 다시 누릅니다.

MEMO

관련된 링크
・ P. 121 초기 동작 오류가 발생했나요?

전원 켜기 및 끄기
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전원 끄기

절차

1. 전원/이동 버튼을 1초 이상 길게 누르십시오.

전원/이동 버튼의 램프와 기기의 전원이 꺼집니다.

전원 켜기 및 끄기
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METAZAStudio 시작하기

절차

1. METAZAStudio를 시작합니다.

• Windows 11
a. [시작]을 클릭합니다.
b. [모든 앱]>[Roland METAZAStudio]>[METAZAStudio]를 클릭합니다.

• Windows 10
a. [시작]을 클릭합니다.
b. [Roland METAZAStudio]>[METAZAStudio]를 클릭합니다.

• Windows 8.1

a. [시작] 화면 좌측 하단에 있는       을 클릭하면 [앱] 화면이 나타납니다.
b. [METAZAStudio]를 클릭합니다.

각인 데이터 준비(METAZAStudio)
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 METAZAStudio 화면

조작 등에 관한 자세한 내용은 METAZAStudio의 온라인 도움말을 참조하십시오.

No. 이름 개요

메뉴 바 METAZAStudio의 다양한 기능을 실행합니다.

툴 바 툴 바에는 [Material] 및 [Open]과 같은 METAZAStudio 기능을 실행
하기 위한 버튼이 있습니다.

테이블 테이블이 여기에 표시됩니다. 표시된 척도는 테이블의 실제 척도 표시를 
나타냅니다.

작업 영역 각인이 가능한 영역입니다. METAZA 드라이버에서 설정한 소재 사이즈 
(각인 영역)를 나타냅니다. 
METAZA 드라이버 설정

중심선 이는 테이블의 수직 중심 위치를 나타냅니다.

그리드 이것은 작업 영역에 표시되는 그리드 라인입니다. 이미지와 텍스트를 
배치하기 위한 가이드 역할을 합니다.

각인 데이터 준비(METAZAStudio)
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No. 이름 개요

여백 이 여백 영역은 작업 영역의 가장자리 내부에 있으며 각인이 수행되지
않습니다.
[File] 메뉴에서 [Preferences]를 선택하면 여백 크기를 변경할 수 있습
니다.
• 초기 설정: 1 mm

Step 1: 소재의 모양과 크기 결정
Step 1: 각인 영역 설정

상태 바 이것은 커서의 현재 위치, 모양에 대한 정보, 그리드 및 보기 배율을 보
여줍니다. 포인터를 툴 바 버튼으로 이동하거나 메뉴 바를 가리키면 버
튼 또는 명령에 대한 간략한 설명이 왼쪽 가장자리에 나타납니다. 모양 
정보는 화면 개체(이미지, 텍스트 또는 모양)를 클릭하면 나타납니다.

현재 커서 위치 이것은 커서의 현재 위치를 나타냅니다. 창의 중앙(두 개의 중심선이 
교차하는 곳)의 위치는 (0, 0)입니다.

페이지 피드 바 변수 필드에 데이터를 입력하면 이를 사용하여 창에 표시되는 페이지
(레코드)를 지정합니다.

그리드 피치 이것은 그리드 라인의 피치(간격)를 표시합니다. 이것을 마우스 오른쪽 
버튼으로 클릭하면 그리드 모양과 관련된 메뉴 항목이 표시됩니다.

배율 보기 이는 창 보기의 현재 배율 계수를 표시합니다. 이를 마우스 오른쪽 버튼
으로 클릭하면 보기 배율 계수를 변경할 수 있는 메뉴가 표시됩니다.

관련된 링크
・ P. 131 소프트웨어 도움말을 표시하는 방법

각인 데이터 준비(METAZAStudio)
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Step 1: 소재의 모양과 크기 결정

각인을 시작하기 전에 METAZAStudio에서 사용할 소재의 모양과 크기를 설정합니다. METAZAStudio에
는 다양한 사전 등록된 소재의 모양이 있습니다.
이 섹션에서는 다음 소재를 사용할 때의 설정을 설명합니다.

사용 소재
미리 등록된 [tag]와 동일한 모양의 소재

• 원통형 소재 및 기타 곡면에 각인하려면 굴곡진 표면에 각인을 참조하십시오.
• 새로운 소재를 등록하려면 새로운 소재 등록을 참조하십시오.

절차

1.    를 클릭합니다.

[Material] 창이 나타납니다.

2. 소재의 모양과 크기를 선택하십시오.

(1) 각인할 소재의 모양을 선택하십시오.

이 예에서는 [tag]를 선택합니다.

(2)        를 클릭합니다.

각인하기 33
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[Material Size] 창이 나타납니다.
(3) 소재의 크기에 대한 값을 입력하고 [OK]를 클릭하십시오.

선택한 소재가 편집 창에 나타납니다. 소재로 표시된 부분은 변경 없이 각인 영역이 됩니다.

34 각인하기
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3. [File]>[Preferences]를 클릭합니다.

[Preferences] 창이 나타납니다.

4. 여백을 설정합니다.

평평한 소재에 각인하려면 여백을 최소 1 mm (0.04 in.)로 만드십시오. 그렇지 않으면 마킹 핀이 소재의 가장자리
를 치고 손상시킬 수 있습니다.

IMPORTANT

각인하기 35
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5. [OK]를 클릭합니다.

관련된 링크
・ P. 23 기기가 각인할 수 있는 소재
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Step 2: 이미지 불러오기

인쇄할 이미지(사진이나 그림 등)를 가져옵니다.

METAZAStudio에서는 다음 파일 형식의 데이터만 가져올 수 있습니다.

MEMO

Illustrator 및 CorelDraw 파일에는 여러 가지 제한이 있습니다. 자세한 내용은 METAZAStudio의 온라인 도움말을 참조
하십시오.
• METAZAStudio 온라인 도움말("Hints and Tips" > "Reusing Existing Data")

• JPEG 포맷
• BMP (비트맵) 포맷
• AI, EPS 포맷 (Illustrator 버전 7.0/8.0 또는 CorelDraw 버전 7/8로 저장된 데이터만) 

 MEMO

절차

1.     를 클릭합니다.

[Import] 창이 나타납니다.

2. 각인할 이미지를 가져옵니다.

(1) [Look in]에서 파일의 위치를 선택하십시오.

(2) [Files of type]에서 [Picture file] 또는 [Adobe Illustrator file]을 선택합니다.

(3) 원하는 파일을 선택합니다.

(4) [Open]을 클릭합니다.

각인하기 37
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지정한 이미지가 각인 영역(①)에 들어와 표시되고, 설정한 여백(②) 내에 정렬됩니다.
불러들인 이미지의 위치, 크기, 각도를 변경하고 프레임을 추가하여 배열할 수 있습니다.

P. 65 이미지 레이아웃을 위한 팁과 요령

구멍이 있는 재료에 인쇄할 때 이미지가 구멍 위에 배치되지 않도록 주의하십시오. 각인 영역(①)에 구멍을 포함
시키면 마킹 핀이 소재의 가장자리에 부딪혀 손상될 수 있습니다.

IMPORTANT
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각인 영역이 구멍 위에 있는 경우 소재의 가장자리에 여백이 없는 경우 각인 영역이 소재를 넘어가는 경우

관련된 링크
・ P. 67 이미지의 위치, 크기 또는 각도 조정

각인하기 39
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Step 3: 텍스트 입력

각인할 텍스트를 입력합니다.

절차

1. 를 클릭합니다.

2. 각인 영역을 클릭하고 텍스트를 입력하십시오.

입력한 텍스트의 위치, 크기, 방향을 변경하고 채울 수 있습니다.
P. 71 텍스트 레이아웃을 위한 팁과 요령

40 각인하기
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Step 4: 각인 데이터 저장

각인 데이터를 파일로 저장합니다.

절차

1.       를 클릭합니다.

[Save As] 창이 나타납니다.

2. 데이터를 저장할 폴더를 지정한 후 파일 이름으로 저장합니다.

각인하기 41
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기기에 소재를 장착합니다. 소재를 고정하려면 다음 포함 항목 중 하나를 사용하여 각인할 소재의 모양과 일
치시킵니다.
센터 바이스와 클램프 핀은 동일한 베이스를 사용합니다. 소재에 맞게 센터 바이스와 클램프 핀을 전환하십
시오.
• 테이블, 접착 시트
• 센터 바이스
• 클램프 핀

접착 시트를 사용하여 소재 장착

기기에 소재 장착

절차

1. 전원을 켭니다.

P. 27 전원 켜기

2. 커버를 엽니다.

3. 노브의 중앙을 바로 아래에 있는 삼각형의 상단(①)에 맞춘 다음 노브를 조입니다.

스토퍼가 고정됩니다. 스토퍼가 느슨한 상태에서 각인을 수행하면 진동으로 인해 노브가 떨어질 수
있습니다.

4. 헤드의 끝 부분에 헤드 캡을 장착합니다.

소재 장착
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다음 그림과 같이 헤드를 가볍게 잡고 장착하십시오. 탭이 딸각거리면 헤드 캡이 올바르게 장착된 
것입니다.

헤드 캡을 사용하지 않고 각인을 수행할 때에도 이때 헤드 캡을 장착하십시오. 이렇게 하면 소재를 장착할 때 
마킹 핀이 손이나 소재에 부딪혀 부상과 소재 손상을 방지할 수 있습니다.

IMPORTANT

5. 기기에 테이블을 장착합니다.

테이블 바닥의 탭(①)을 기기의 구멍(②)에 맞춰 끼웁니다.

6. 테이블에 접착시트를 붙입니다.

접착 시트를 부착할 때 다음 사항에 유의하십시오.

• 테이블의 눈금 표시에 맞춰 똑바로 놓습니다.
• 테이블 프레임 안에 놓습니다.
• 접착 시트와 테이블 사이에 공기 방울이 생기지 않도록 주의합니다.

소재 장착
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접착 시트의 접착력이 약해진 경우, 접착 시트를 세척하십시오. 또한 너무 세게 문지르는 등 표면을 손상시키지 
않도록 주의하십시오. 표면이 손상되고 접착력이 떨어질 수 있습니다.

MEMO

7. 소재를 가볍게 눌러 장착합니다.

소재가 테이블 안에 장착 할수 있을 만큼 작은 경우 소재가 테이블 안에 장착 할수 없을 만큼 큰 경우

소재의 중심(②)이 테이블 위 그리드의 중심(①)에 오도록 소
재를 배치 합니다.

각인 영역(②)의 중심이 테이블 위의 그리드(①)의 중심에 오
도록 소재를 배치합니다. 소재가 기울어지면 각인 표면이 수

평을 유지하도록 지지대를 사용합니다.

관련된 링크
・ P. 101 접착 시트 청소

소재 장착
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각인 시작 높이 설정

손상되기 쉬운 소재의 경우, 인쇄를 시작할 높이를 설정하고 인쇄를 시작하기 전에 헤드 캡을 분리하십시
오.
헤드 캡을 사용하여 각인을 수행하는 경우 이 섹션의 작업을 수행할 필요가 없습니다.

절차

1. 전원/이동 버튼을 누릅니다.

헤드 캡의 끝 부분이 소재 표면에 안착되는 위치에서 헤드가 이동하고 정지합니다.

2. 노브를 느슨하게 합니다.

노브를 반시계 방향으로 한 번 돌립니다. 그러면 스토퍼를 움직일 수 있습니다.

3. 스토퍼를 가장 낮은 위치까지 내린 후 노브를 조이십시오.

4. 전원/이동 버튼을 누릅니다.

헤드가 왼쪽 뒤로 이동합니다.

각인하기 45
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5. 헤드 부분을 지지한 채로 헤드 캡을 분리합니다.

헤드를 받치고 손가락을 헤드 캡의 튀어나온 테두리에 놓으면 캡을 쉽게 분리할 수 있습니다.
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센터 바이스를 사용하여 소재 장착

센터 바이스 사용

소재 고정

센터 바이스를 사용하여 클램핑하여 소재를 고정합니다. 바이스를 사용할 때 바이스의 방향과 앞면과 뒷면을 
변경할 수도 있습니다. 소재의 크기와 모양에 맞는 방식으로 사용하십시오.

판형 소재의 클램핑에 적합합니다. 원통형 소재를 클램핑하는 데 적합합니다.

기기에 센터 바이스 고정

센터 바이스를 기기에 장착하는 방법은 수직 장착(A)과 수평 장착(B)의 두 가지가 있습니다. 소재 크기(①)
와 각인 영역(②)에 따라 적절한 방법을 선택하십시오.
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A

B

관련된 링크
・ P. 23 기기가 각인할 수 있는 소재
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기기에 소재 장착

절차

1. 전원을 켭니다.

P. 27 전원 켜기

2. 커버를 엽니다.

3. 노브의 중앙을 바로 아래에 있는 삼각형 상단(①)에 맞추고 노브를 조입니다.

스토퍼가 고정됩니다. 스토퍼가 느슨한 상태에서 각인을 수행하면 진동으로 인해 노브가 떨어질 수
있습니다.

4. 헤드의 끝부분에 헤드캡을 장착합니다.

다음 그림과 같이 헤드를 가볍게 잡고 장착합니다. 탭이 딸각거리면 헤드 캡이 올바르게 장착된 것
입니다.

헤드 캡을 사용하지 않고 각인을 수행할 때에도 이때 헤드 캡을 장착하십시오. 이렇게 하면 소재를 장착할 때 
마킹 핀이 손이나 소재에 부딪혀 부상과 소재 손상을 방지할 수 있습니다.

IMPORTANT
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5. 센터 바이스에 소재를 올려놓은 후 고정 나사를 조입니다.

소재가 잘 고정 되도록 고정 나사를 충분히 조이십시오. 너무 많이 조이면 소재가 손상될 수 있으므로 
너무 조이지 않도록 주의하십시오.

6. 기기에 센터 바이스를 장착합니다.

센터 바이스 바닥의 탭(①)을 기기의 구멍에 맞춥니다. 소재를 가로로 배열할 때 ②에 표시된 방향
으로 탭을 정렬합니다. 소재를 수직으로 배열할 때는 탭을 ③에서 표시한 방향으로 정렬합니다.
소재가 기울어지면, 소재가 수평을 유지할 수 있도록 지지대를 사용합니다.
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각인 시작 높이 설정

손상되기 쉬운 소재의 경우, 인쇄를 시작할 높이를 설정하고 인쇄를 시작하기 전에 헤드 캡을 분리하십시
오.

헤드 캡을 사용하여 각인을 수행하는 경우 이 섹션의 작업을 수행할 필요가 없습니다.

절차

1. 전원/이동 버튼을 누릅니다.

헤드가 움직이며 헤드 캡 끝이 소재 표면에 닿는 위치에서 멈춥니다.

2. 노브를 느슨하게 합니다.

노브를 반시계 방향으로 한 번 돌립니다. 그러면 스토퍼를 움직일 수 있습니다.

3. 스토퍼를 가장 낮은 위치까지 누른 다음 노브를 조입니다.

4. 전원/이동 버튼을 누릅니다.

헤드가 왼쪽 뒤쪽으로 이동합니다.
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5. 헤드 부분을 지지한 채로 헤드 캡을 분리합니다.

헤드를 받치고 손가락을 헤드 캡의 튀어나온 테두리에 놓으면 캡을 쉽게 분리할 수 있습니다.
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클램프 핀을 사용하여 소재 장착

클램프 핀 사용

소재 고정

클램프 핀은 클램프로 소재를 잡아 고정합니다. 클램프를 사용할 때 방향을 앞면과 뒷면으로 변경할 수도 있
습니다. 소재의 크기와 모양에 맞는 방식으로 사용하십시오.

원통형 소재를 클램핑하는 데 적합합니다.

기기에 클램프 핀 고정하기

클램프 핀을 기기에 장착하는 방법은 수직 장착(A)과 수평 장착(B)의 두 가지가 있습니다. 소재 크기(①)
와 각인 영역(②)에 따라 적절한 방법을 선택하십시오.
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관련된 링크
・ P. 23 기기가 각인할 수 있는 소재
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기기에 소재 장착

절차

1. 전원을 켭니다.

P. 27 전원 켜기

2. 커버를 엽니다.

3.   노브의 중앙을 바로 아래의 삼각형 상단에 맞춘 후(①), 노브를 조입니다.

스토퍼는 고정되어 있습니다. 스토퍼가 느슨한 상태에서 각인을 수행하면 진동으로 인해 노브가 
떨어질 수 있습니다.

4. 헤드의 끝 부분에 헤드 캡을 장착합니다.

다음 그림과 같이 헤드를 가볍게 잡고 장착합니다. 탭이 딸각거리면 헤드 캡이 올바르게 장착된 것
입다.

헤드 캡을 사용하지 않고 각인을 수행할 때에도 이때 헤드 캡을 장착하십시오. 이렇게 하면 소재를 장착할 때 
마킹 핀이 손이나 소재에 부딪혀 부상과 소재 손상을 방지할 수 있습니다.

IMPORTANT
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5. 클램프 핀에 소재를 올려놓은 후, 고정 나사를 조입니다.

소재가 쉽게 풀리지 않도록 고정 나사를 충분히 조이십시오. 너무 조이면 재료가 손상될 수 있으므로 
너무 조이지 않도록 주의하십시오.

6. 클램프 핀을 기기에 장착합니다.

클램프 핀 바닥의 탭(①)을 기기의 구멍에 맞춥니다. 소재를 가로로 배열할 때는 탭을 ②에서 표시된 
방향으로 정렬합니다. 소재를 수직으로 배열할 때는 탭을 ③에서 표시된 방향으로 정렬합니다.
소재가 기울어지면, 소재가 수평을 유지할 수 있도록 지지대를 사용합니다.
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각인 시작 높이 설정

손상되기 쉬운 소재의 경우, 각인을 시작할 높이를 설정하고 인쇄를 시작하기 전에 헤드 캡을 분리하십시
오.

헤드 캡이 분리되면 헤드가 소재의 높이를 추적할 수 없으므로 곡면에 각인하는 것이 불가능합니다.

MEMO

헤드 캡을 사용하여 각인을 수행하는 경우 이 섹션의 작업을 수행할 필요가 없습니다.

절차

1. 전원/이동 버튼을 누르십시오.

헤드가 움직여 헤드 캡의 끝이 테이블 중앙에 있는 상태에서 멈춥니다.

2. 노브를 느슨하게 합니다.

손잡이를 반시계 방향으로 한 번 돌립니다. 그러면 스토퍼를 움직일 수 있습니다.

3. 스토퍼를 가장 낮은 위치까지 누른 다음 노브를 조입니다.

노브의 중앙을 바로 아래의 삼각형 상단에 맞춘 후(①), 스토퍼를 고정합니다.
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4. 전원/이동 버튼을 누릅니다.

헤드가 왼쪽 뒤로 이동합니다.

헤드 부분을 지지한 채로 헤드 캡을 분리합니다.
헤드 캡의 튀어나온 테두리에 손가락을 대면 캡을 더 쉽게 분리할 수 있습니다.

MEMO
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각인 시작

각인 데이터를 기기로 보내고 각인을 시작합니다. 기기와 컴퓨터가 제공된 USB 케이블로 연결되어 있는지 
확인합니다.

헤드, 테이블 등의 부품이 손상되는 것을 방지하기 위해 다음과 같은 상황에서는 각인을 시작하지 마십시오.

• 소재가 장착되지 않은 경우
• 헤드 캡을 사용하지 않는 경우 소재의 표면 높이에 따라 헤드가 적절한 위치에 설정되지 않은 경우

IMPORTANT

절차

1. 커버를 닫습니다.

2.        를 클릭합니다.

[Print] 창이 나타납니다.

3. [Name]에 [Roland MPX-90]이 선택되어 있는지 확인한 후 [Properties]를 클릭합니다.

4. 각인 설정을 구성합니다.

각인 시작 및 중지
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(1) [Image Correction] 탭을 클릭합니다.

(2) [Material]을 선택합니다.
소재의 구성이나 제품 코드를 선택하십시오. 타격력을 조정하고 등록할 수 있습니다.
구성 등록 및 타격력 조정(P. 107)

(3) 각인 모드를 선택합니다.

구성 등록 및 타격력 조정(P. 107)
METAZA 드라이버 온라인 도움말([Image Correction] 탭)

(4) [OK]를 클릭합니다.

5. [Print] 창에서 [OK]를 클릭합니다.

각인 데이터가 기기로 전송되고 각인이 시작됩니다.

6. 각인이 완료된 후 커버를 열고 소재를 분리합니다.

헤드가 왼쪽 뒤 모서리로 이동하고 작동이 완전히 멈출 때까지 커버를 열지 마십시오.

각인 시작 및 중지
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접착 시트를 사용할 때 소재가 분리하기 어려운 경우, 접착 시트와 소재 사이에 얇고 평평한 물체
(예: 골판지 조각)를 삽입하면 분리하기가 더 쉬울 수 있습니다.

관련된 링크
・ P. 42 소재 장착

각인 시작 및 중지
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각인 작업 중지

각인이 중지되면 기기로 전송된 각인 데이터가 삭제되므로 각인을 다시 시작할 수 없습니다.
다시 인쇄하려면 인쇄 데이터를 기기로 다시 보내십시오.

기기에서 각인 중지

절차

1. 전원/이동 버튼을 1초 이상 누릅니다.

램프가 깜빡거리고, 기기로 전송된 각인 데이터가 삭제됩니다. 각인을 다시 시작할 수 없습니다.
각인 데이터 삭제가 완료되면 기기가 꺼집니다.

다시 각인하려면 스토퍼 노브를 풀고 기기를 켭니다. 각인 시작 높이를 설정한 다음 각인을 다시 수행합니다.

MEMO

관련된 링크
・ P. 27 전원 켜기
・ P. 42 소재 장착
・ P. 59 각인 시작
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컴퓨터에서 각인 정지

절차

1. 장치 및 프린터 목록을 표시합니다.

• Windows 11
a. [시작]>[모든 앱]>[Windows Tools]을 클릭합니다.
b. [제어판]을 클릭합니다.
c. [장치 및 프린터 보기]를 클릭합니다.

• Windows 10
a. [시작]>[윈도우 시스템]>[제어판]을 클릭합니다.
b. [장치 및 프린터 보기]를 클릭합니다.

• Windows 8.1
a. 포인터를 화면 오른쪽 하단으로 이동하여 참 바를 표시한 후 [설정]을 클릭합니다.
b. [제어판]을 클릭합니다.
c. [장치 및 프린터]를 클릭합니다.

2. [Roland MPX-90] 아이콘을 더블클릭합니다.

3. [프린터] 메뉴에서 [모든 문서 취소](또는 [인쇄 문서 제거])를 클릭합니다.

4. 확인 창이 나타나면 [예]를 클릭하십시오.
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각인 데이터 처리

64 각인 데이터 처리

이미지 레이아웃을 위한 팁과 요령 .......................................................................................... 65
이미지의 필요한 부분만 유지(트리밍) ................................................................................ 65
이미지의 위치, 크기 또는 각도 변경 .................................................................................. 67
프레임에 이미지 넣기 ................................................................................................... 69

텍스트 레이아웃을 위한 팁과 요령 .......................................................................................... 71
텍스트의 위치, 크기 또는 각도 변경 .................................................................................. 71
부채꼴 레이아웃에 텍스트 배치 ....................................................................................... 73
도형을 따라 텍스트 배치 ................................................................................................ 75
텍스트 채우기 ............................................................................................................ 78

스트로크 텍스트 생성 및 편집 ................................................................................................ 80
 SFEdit2 화면 ............................................................................................................. 80
스트로크 텍스트 글꼴 만들기 .......................................................................................... 82
입력 텍스트를 스트로크 텍스트로 변경하기 .......................................................................... 84
스트로크 텍스트 편집 하기 ............................................................................................. 86

이미지의 최종 결과 확인 및 조정 ............................................................................................ 88
미리보기 창에서 완성된 결과 확인 .................................................................................... 88
미리보기 창에서 완성된 결과 조정 .................................................................................... 90

굴곡진 표면에 각인 ............................................................................................................ 91
Step 1: 각인 영역 설정 ................................................................................................. 91
Step 2: 세로형 소재에 가로로 텍스트 작성 .......................................................................... 94

새로운 소재 등록 ............................................................................................................... 97
다양한 소재를 등록하는 방법 .......................................................................................... 97

METAZA 드라이버 설정 ....................................................................................................... 98
METAZA 드라이버 설정 유지 .......................................................................................... 98

실용적인 응용 방법 ............................................................................................................ 99
METAZAStudio의 실용적인 응용 방법 ............................................................................... 99



이미지의 필요한 부분만 유지(트리밍)

METAZAStudio는 원본 이미지를 잘라내어 불필요한 영역을 제거하고 필요한 부분만 남길 수 있습니다. 
이 작업을 "트리밍"이라고 합니다.

절차

1.     를 클릭합니다.

2. 이미지를 클릭합니다.

이미지 주위에 8개의 트리밍 막대가 나타납니다.

3. 이미지를 잘라냅니다.

다듬기 막대를 드래그하여 유지하려는 영역을 다듬습니다.

이미지 레이아웃을 위한 팁과 요령
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관련된 링크
・ P. 30 각인 데이터 준비(METAZAStudio)

이미지 레이아웃을 위한 팁과 요령
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이미지의 위치, 크기 또는 각도 조정

METAZAStudio를 사용하면 배치된 이미지의 위치, 크기, 각도를 변경하여 원하는 레이아웃을 구현할 수 
있습니다. 

절차

1.     를 클릭합니다.

2. 이미지를 드래그하여 위치를 조정하십시오.

이미지를 클릭하면 이미지의 네 모서리에 핸들(      )이 표시됩니다. 핸들이 표시된 상태에서 이미지를 

드래그하여 위치를 조정합니다.

3. 이미지의 네 모서리에 있는 핸들(       )을 드래그하여 크기를 조정하십시오.

4. 이미지의 네 모서리에 핸들(       )이 있는 상태에서 이미지를 다시 클릭합니다.

이미지 레이아웃을 위한 팁과 요령

각인 데이터 처리 67



네 모서리의 핸들 모양이 (      )으로 변경됩니다.

5. 포인터를 핸들에 맞춘 후 드래그하여 이미지의 각도를 조정하십시오.

포인터를 핸들에 맞춰           을 표시고 이미지의 각도를 조정합니다.

드래그할 때 키보드의 "SHIFT" 키를 누르고 있으면 각도가 한 번에 45도씩 변경됩니다. 이 방법을 사용하면 정
확히 90도 회전을 수행하고 싶을 때와 같은 상황에 편리할 수 있습니다.

MEMO

각도가 변경된 이미지에는 트리밍을 수행할 수 없습니다. 트리밍을 수행하려면 이미지 각도를 변경하기 전에 
수행하십시오.

MEMO
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프레임에 이미지 넣기

이미지 주위에 프레임을 배치하여 각인 데이터의 배열을 변경할 수 있습니다. 
METAZAStudio에서는 다양한 유형의 프레임이 [Library]에 미리 등록되어 있습니다. 
새로운 프레임을 등록할 수도 있습니다. 절차에 대한 자세한 내용은 METAZAStudio의 온라인 도움말을 
참조하십시오. 
METAZAStudio 온라인 도움말("Hints and Tips" > "Making Use of Library")

절차

1.     를 클릭합니다.

[Library] 창이 나타납니다.

2. 프레임을 삽입합니다.

(1) [Group]에서 [Frame]을 선택합니다.

(2) [Icon]을 선택하십시오.

(3) 삽입할 프레임을 클릭합니다.

(4)             을 클릭합니다.

이미지에 프레임이 삽입됩니다.
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3. 프레임의 크기와 위치를 조정합니다.

프레임의 크기가 소재의 크기보다 큰 경우, 각인 영역 외부에 핸들이 나타납니다. 이미지를 조정

하는 것과 같은 방식으로 프레임을 조정합니다.

• ①: 프레임

관련된 링크
・ P. 67 이미지의 위치, 크기 또는 각도 조정
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텍스트의 위치, 크기 또는 각도 변경

배치된 텍스트의 위치, 크기, 각도를 이미지와 마찬가지로 변경할 수 있습니다. 

절차

P. 40 Step 3: 텍스트 입력

1. 텍스트 위치를 조정합니다.

(1) 텍스트를 입력합니다.

(2)       를 클릭합니다.

(3) 레이아웃된 텍스트를 클릭합니다.

텍스트 주위에 8개의 핸들이 나타납니다.
(4) 텍스트를 드레그 하여 위치를 조정합니다.

2. 핸들을 드래그하여 크기를 조정합니다.

3. 텍스트의 각도를 조정합니다.

(1) 텍스트를 클릭하고 사각형 핸들이 (       )로 바뀔 때까지 마우스 버튼을 누르고 있습니다.

(2) 포인터를 핸들과 일렬로 맞춥니다.

포인터 모양이           로 변경됩니다.

(3) 핸들을 드래그하여 텍스트의 각도를 변경합니다.

MEMO

텍스트 레이아웃을 위한 팁과 요령
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드래그할 때 키보드의 "SHIFT" 키를 누르고 있으면 각도가 한 번에 45도씩 변경됩니다. 이 방법을 사용
하면 정확히 90도 회전을 수행하고 싶을 때와 같은 상황에 편리할 수 있습니다.



텍스트 레이아웃을 위한 팁과 요령
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부채꼴 레이아웃에 텍스트 배치

텍스트를 부채꼴 모양으로 배열할 수 있습니다. 

절차

1. 텍스트를 입력합니다.

P. 40 Step 3: 텍스트 입력

2.     를 클릭합니다.

[Properties] 창이 나타납니다.

3. 텍스트 배치를 설정합니다.

(1) Format 탭을 클릭합니다.

(2) [Align with Curve] 확인란을 선택합니다.

(3) [OK]를 클릭합니다.

텍스트의 레이아웃이 부채꼴 모양으로 변경됩니다.

텍스트 레이아웃을 위한 팁과 요령
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도형을 따라 텍스트 배치

그리기 도구를 사용하여 만든 도형을 따라 텍스트를 배치합니다.

통합 폴리라인에는 텍스트를 배치할 수 없습니다.
METAZAStudio 온라인 도움말("Commands" - "[Object] menu" - "Convert to Polyline", "Integrate Polyline")

MEMO

절차

1. 그리기 도구를 클릭합니다.

이 예에서는       을 사용합니다.

2. 편집창에서 소재 위에 모양을 만듭니다.

METAZAStudio 온라인 도움말("Commands" - "Toolbar Buttons")
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3.     를 클릭합니다.

4. 생성한 도형의 윤곽선 근처에 포인터를 놓고 포인터 아래에            이 나타나면 클릭합니다.

5. 텍스트를 입력합니다.

텍스트가 도형을 따라 배치됩니다.
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관련된 링크
・ P. 40 STEP 3: 텍스트 입력
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텍스트 채우기

텍스트를 채우는 방법은 [Fill]와 [IslandFill] 두 가지가 있습니다. 원하는 방법을 선택하십시오.

Fill

공백 없이 텍스트가 채워집니다.

Island Fill

인접한 채우기 선 사이의 간격을 지정할 수 있습니다.

알루미늄 소재 등에 선이 많은 각인(Island Fill 등)을 할 경우 소재 표면의 요철이 커져 헤드 캡이 더 빨리 마모됩니다. 
헤드 캡의 상태를 주기적으로 점검하여 필요에 따라 교체하십시오.

MEMO

절차

1. 텍스트를 입력합니다.

2.        를 클릭합니다.

[Properties] 창이 나타납니다.

3. 텍스트의 채우기 및 윤곽선을 설정합니다.

(1) [Fill and Contour] 탭을 클릭합니다.

(2) [Fill] 확인란을 선택합니다.

(3) [Fill] 또는 [Island Fill]를 선택하십시오.

[Island Fill]를 선택한 경우, 피치를 입력해야 합니다.

피치는 인접한 채우기 선 사이의 간격입니다.

MEMO

(4) [OK]를 클릭합니다.

텍스트가 채워집니다.
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관련된 링크
・ P. 115 헤드 캡 교체 주기
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SFEdit2를 사용하여 스트로크 문자 글꼴을 만들고 편집할 수 있습니다. METAZAStudio에서 SFEdit2로 
만들고 편집한 스트로크 문자 글꼴을 사용할 수 있습니다.

 SFEdit2 화면

No. 이름 개요

메뉴 바 SFEdit2에 대한 다양한 기능을 실행합니다. 
SFEdit2 도움말 ("Commands")

툴 바 툴바에는 [Open...] 및 [Save]과 같은 SFEdit2 기능을 실행하기 위한 
버튼이 제공됩니다.
SFEdit2 도움말("Commands" - "Toolbar buttons")

캐릭터 목록 이것은 모든 스트로크 텍스트 목록을 표시합니다. 스트로크 텍스트를 
편집하려면 클릭합니다.

텍스트 상자 이것은 텍스트를 둘러싸기 위한 상자입니다. 상자의 크기는 기본 글꼴 
유형과 문자에 따라 다릅니다. 일반적으로 상자 안에 맞게 텍스트를 만
들어야 합니다.

기본 글꼴 텍스트 스트로크 텍스트의 디자인 기반은 스트로크 텍스트를 편집하기 위한 
초안으로 표시됩니다.

스트로크 문자 이것은 기본 글꼴에서 중심선을 추출하여 만든 선 그림입니다. 모든 스
트로크 텍스트는 폴리라인으로 구성되어 있습니다. 앵커 포인트를 추가
하거나 삭제하고 선분을 추가할 수 있습니다.
SFEdit2 도움말("Operation Procedures" > "Step 2: Edit the shape 
of char-acter")

기준선 이것은 텍스트 문자열을 수평으로 정렬하기 위한 기준선입니다. 텍스트
가 수평으로 작성될 때, 인접한 문자의 기준선은 수평선을 따라 정렬되
어 고르지 않은 부분이 없습니다.

스트로크 텍스트 생성 및 편집
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①

②

③

④

⑤

⑥

⑦



No. 이름 개요

상태 바 툴바 버튼으로 포인터를 옮기거나 메뉴 기능을 가리키면 해당 버튼이나 
기능에 대한 간략한 설명이 표시됩니다.

스트로크 텍스트 생성 및 편집
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⑧



스트로크 텍스트 글꼴 만들기

스트로크 텍스트 글꼴을 만들고 저장하는 방법은 아래와 같습니다. 

절차

1. METAZAStudio를 시작합니다.

P. 30 METAZAStudio 시작하기

2. [Edit]>[Stroke Font]>[Run SFEdit2]를 클릭합니다. 

SFEdit2가 시작 됩니다.

3. [File]>[New]를 클릭합니다.

[Select Base Font] 창이 나타납니다.

4. 생성할 스트로크 텍스트 글꼴의 기준으로 사용할 글꼴을 선택한 후 [OK]를 클릭합니다.

스트로크 텍스트 글꼴이 자동으로 생성됩니다.

스트로크 텍스트 생성 및 편집

  5.        를 클릭합니다.
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[Save] 창이 나타납니다.

6. [Stroke Font Name]에 이름을 입력하고 [OK]를 클릭합니다.

7. SFEdit2를 닫습니다.
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입력 텍스트를 스트로크 텍스트로 변경하기

이 섹션에서는 METAZAStudio를 사용하여 입력한 텍스트를 스트로크 텍스트로 변경하는 방법을 설명합니
다. 스트로크 텍스트 글꼴을 사용하려면 다음 작업 중 하나를 미리 수행해야 합니다.

• SFEdit2가 설치되면 스트로크 텍스트 글꼴을 만듭니다.
• 새로운 스트로크 텍스트 글꼴을 만듭니다.

절차

1. 텍스트를 입력합니다.

2.        를 클릭합니다.

[Properties] 창이 나타납니다.

3. 문자 형식을 설정합니다.

(1) [Format] 탭을 클릭합니다.

(2) [Stroke Font]를 선택합니다.

[Font]에 대한 옵션은 스트로크 텍스트로 제한됩니다.
(3) 스트로크 텍스트 글꼴을 선택합니다.

(4) [OK]를 클릭합니다.

입력 문자는 스트로크 텍스트로 변환됩니다.
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관련된 링크
・ P. 82 스트로크 텍스트 글꼴 만들기
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스트로크 텍스트 편집

SFEdit2를 사용하면 생성된 스트로크 텍스트의 모양을 편집할 수 있습니다. SFEdit2를 사용하여 스트로크 
텍스트를 편집하는 절차는 아래에 설명되어 있습니다.

절차

1. 입력 문자를 스트로크 텍스트로 변경합니다.

P. 84 입력 텍스트를 스트로크 텍스트로 변경하기

2. 편집하려는 스트로크 텍스트를 클릭하십시오.

스트로크 텍스트 주위에 8개의 핸들이 나타납니다.

3. [Edit]>[Stroke Font]>[Edit Stroke]를 클릭합니다.

SFEdit2가 시작됩니다.

4. 문자 목록에서 편집하려는 스트로크 텍스트를 클릭합니다.

편집하려는 스트로크 텍스트가 텍스트 상자에 표시됩니다.
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5. 스트로크 텍스트 편집하기

스트로크 텍스트의 위치와 모양을 변경합니다.
SFEdit2 도움말("Editing Polylines")

6. 편집한 스트로크 텍스트를 저장합니다.

(1)        를 클릭합니다.

선택된 스트로크 텍스트 글꼴이 편집된 세부 정보로 덮어쓰여집니다.
(2) SFEdit2를 닫습니다.

편집된 내용이 적용된 스트로크 텍스트가 저장됩니다.
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미리보기 창에서 완성된 결과 확인

미리보기 창에서 인쇄 결과를 확인할 수 있습니다. 

절차

1.        를 클릭합니다.

미리보기 창이 나타납니다.

이미지의 최종 결과 확인 및 조정

88 각인 데이터 처리



미리보기 창

이미지의 최종 결과 확인 및 조정
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미리보기 창에서 완성된 결과 조정

미리 보기 창에서 밝기, 대비 및 감마 보정을 조정할 수 있습니다. 밝고 어두운 영역이 명확하게 정의된 
이미지는 매력적인 각인 결과를 생성합니다.

절차

1. 미리보기 창을 확인하면서 값을 조정하십시오.

Brightness (①)
이것은 전반적인 밝기를 조정합니다. 값을 너무 크게 하면 균형이 깨질 수 있으므로 절대적으
로 필요한 최소한으로 조정하는 것이 좋습니다.

Contrast (②)
이것은 주로 하이라이트(가장 밝은 부분)와 섀도우(가장 어두운 부분)를 조정합니다. 이것을 사용
하면 빛과 어둠의 균형이 잘 잡혀 긴장감을 구현할 때 효과적일 수 있습니다.

Gamma (③)
이것은 주로 밝은 부분과 어두운 부분 사이의 중간 밝기 톤의 밝기를 조정합니다. 이를 사용하면 
전체 밝기를 조정하는 데 효과적입니다.

이미지의 최종 결과 확인 및 조정
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이 기기는 헤드 캡을 사용하여 표면 높이가 균일하지 않은 원통이나 기타 소재에 각인을 수행할 수 있습니다.

Step 1: 각인 영역 설정

먼저, 소재의 각인 영역에 대한 설정을 구성합니다. 원통형 소재에 각인하는 경우, 소재의 전체 표면에 각인
하는 것은 불가능합니다(평평한 소재와 같이). 이러한 이유로 METAZAStudio 편집 창은 소재 대신 각인 영
역을 표시합니다.
각인 영역은 드라이버의 설정 창에 입력된 소재의 직경 값에 따라 결정됩니다.
이 기기로 각인 할 수 있는 원통형 소재의 조건에 대한 자세한 내용은 다음 교차 참조의 "곡면을 각인할 때
소재의 조건"을 참조하십시오. 기기가 각인할 수 있는 소재

절차

1. [File]>[Preferences]를 클릭합니다.

[Preferences] 창이 나타납니다.

2. [Margin]에 0밀리미터를 지정한 후 [OK]를 클릭합니다.

원통형 소재에 각인할 때는 여백을 0밀리미터로 설정합니다. 평평한 소재에 비해 원통형 소재에 각
인할 때는 각인 영역이 제한되므로 여백 크기를 0밀리미터로 만들어 충분한 각인 영역을 확보해야
합니다.

굴곡진 표면에 각인
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3. [OK]를 클릭합니다.

4. [File]>[Set up the printer]를 클릭합니다.

[Set up the printer] 창이 나타납니다.

5. [Name]에 [Roland MPX-90]이 선택되어 있는지 확인한 후 [Properties]를 클릭합니다.

굴곡진 표면에 각인
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6. 각인 영역을 설정합니다.

(1) [Material] 탭을 클릭합니다.

(2) [Cylinder-shaped]에 소재의 직경과 방향을 입력하십시오.

소재를 센터 바이스 또는 클램프 핀 방향으로 배치합니다.
(3) [Enter]를 클릭합니다.

[Work Size]에서 [Width] 값은 자동으로 설정됩니다.
(4) [OK]를 클릭합니다.

7. [Set up the printer] 대화 상자에서 [OK]를 클릭합니다.

이것으로 각인 영역 설정 구성이 완료됩니다.

굴곡진 표면에 각인
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Step 2: 세로형 소재에 가로로 텍스트 작성

이미지와 텍스트를 설정된 각인 영역에 배치합니다. 이 섹션에서는 세로형 소재에 수평으로 문자를 입력
하는 방법을 설명합니다.

절차

1. 인쇄할 텍스트를 입력한 후 배치 방식을 조정합니다.

P. 40 Step 3: 텍스트 입력

2. 원하는 크기로 텍스트 크기를 변경하십시오.

텍스트는 각인 영역 내에 맞아야 합니다.
P. 71 텍스트의 위치, 크기 또는 각도 변경

3. 입력 텍스트를 90˚회전하여 수직으로 만듭니다.

P. 71 텍스트의 위치, 크기 또는 각도 변경
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4.       를 클릭합니다.

5.   키보드의 [→] 키(왼쪽 화살표 키)를 누릅니다.

텍스트 아래에 깜박이는 커서가 나타납니다.

6. 나머지 텍스트를 입력하고 텍스트를 원하는 위치로 이동합니다.

P. 71 텍스트의 위치, 크기 또는 각도 변경

화면상의 임프린트 영역 스케일은 그림에서 보여지는 센터 바이스의 스케일과 일치합니다. 기기에서 소재의 
위치를 조정하여 원하는 위치에 텍스트를 각인할 수 있도록 합니다.

P. 49 기기에 소재 장착

MEMO
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다양한 소재를 등록하는 방법

METAZAStudio에는 다양한 사전 등록된 소재가 있습니다. METAZAStudio에 등록되지 않은 모양의 소재를 
각인하려면 먼저 새 소재로 등록해야 합니다. 이렇게 하면 각인 영역이 제한되는 것을 방지하고 소재의 가장
자리에 부딪혀 마킹 핀이 손상되는 것을 방지할 수 있습니다.
소재를 등록하는 방법에는 다음 세 가지 방법이 있습니다. 절차에 대한 자세한 내용은 METAZAStudio의 온
라인 도움말을 참조하십시오.

비트맵 이미지 가져오기

소재 모양의 이미지가 있는 경우 다음 조건을 충족하는 한 이미지를 가져올 수 있습니다. 그러나 비트맵 데
이터만 사용할 수 있습니다.
• 파일 확장자: BMP 또는 JPEG
• 색상: 바이너리(흑백-소재에 해당하는 부분은 반드시 검정색으로 채워져야 함)

시중에서 판매하는 스캐너로 소재 스캔하기

소재의 이미지가 없거나 소재의 모양이 복잡한 경우 시중에서 판매하는 스캐너로 소재를 스캔하여 생성된 
이미지를 가져올 수 있습니다. 다음 조건을 충족하는 스캐너를 사용하십시오.
• 색상: 바이너리(흑백-소재에 해당하는 부분은 반드시 검정색으로 채워져야 함)

소재의 모양 그리기

소재가 정사각형, 원형 또는 이와 같은 간단한 모양인 경우, 그리기 도구를 단독으로 또는 조합하여 사용하
여 소재의 모양을 그린 다음 등록할 수 있습니다.

관련된 링크
・ P. 131 소프트웨어 도움말을 표시하는 방법
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METAZA 드라이버 설정 유지

METAZA Driver의 설정 창에서는 소재의 크기와 각인에 사용되는 방법을 포함하여 다양한 항목에 대한 설정
을 할 수 있습니다. 이 창(여기에 설명된 절차를 사용하여 표시된 창)에서 변경한 내용은 METAZAS-tudio
를 다시 시작한 후에도 그대로 유지됩니다.

절차

1. 장치 및 프린터 목록을 표시합니다.

• Windows 11
a. [시작]>[모든 앱]>[Windows Tools]을 클릭합니다.
b. [제어판]을 클릭합니다.
c. [장치 및 프린터 보기]를 클릭합니다.

• Windows 10
a. [시작]>[Windows System]>[제어판]을 클릭합니다.
b. [장치 및 프린터 보기]를 클릭합니다.

• Windows 8.1
a. 화면 오른쪽 하단으로 포인터를 이동하여 참바를 표시한 후 [설정]을 클릭합니다.
b. [제어판]을 클릭합니다.
c. [장치 및 프린터]를 클릭합니다.

2. [Roland MPX-90]을 마우스 오른쪽 버튼으로 클릭한 후 [인쇄 기본 설정]을 클릭합니다.

METAZA 드라이버 설정 창이 나타납니다.

METAZAStudio [File] 메뉴로 가서 [Print Setup]을 클릭한 후, [Print Setup] 창에서 [Properties]를 클릭하면 
위의 절차에서 열린 것과 동일한 설정 창이 표시됩니다.
이 창에서 변경한 내용은 METAZAStudio를 다시 시작하면 사라집니다. METAZA 드라이버 설정을 일시적으로 
변경할 때 이 창을 사용하는 것이 좋습니다.

MEMO

 METAZA 드라이버 설정
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METAZAStudio의 실용적인 응용 방법

METAZAStudio에는 이 문서에서 설명하지 않은 몇 가지 추가 유용한 기능이 있습니다. 주요 기능은 아래에 
나와 있습니다. METAZAStudio를 작동하는 방법에 대한 자세한 내용은 프로그램의 온라인 도움말을 참조
하십시오.

인물의 이미지를 더욱 돋보이게 하기

METAZAStudio를 사용하여 만든 데이터를 기기가 각인할 때, 밝고 어두움은 흰색에 가까운 색상을 더 어
둡게 하고 검은색에 가까운 색상을 더 밝게 표현합니다. 즉, 어두운 머리카락이나 옷은 밝게 각인되어 사
람의 윤곽이 불분명해질 수 있습니다. (데이터에 따라 이러한 머리카락이나 옷은 전혀 각인되지 않을 수 
있습니다.)
이런 경우, 사람을 잘라내고 이미지에 테두리를 적용하면 인쇄 시 사람의 이미지가 더 돋보이게 만들 수 
있습니다.

자주 사용하는 도형, 이미지를 사전에 등록
자주 사용하는 모양과 일반적으로 사용하는 모양을 라이브러리에 등록하면 필요할 때마다 불러와 데이터
에 추가할 수 있습니다. 로고와 기타 그래픽을 등록하면 편리함을 더할 수 있습니다. 이미지도 등록할 수 
있습니다.

이미지에서 윤곽선 만들기

가져온 이미지에 윤곽선을 추가하여 각인할 수 있습니다. 가져올 수 있는 데이터 형식은 JPEG와 
BMP(비트맵)입니다. 윤곽선을 깨끗하게 추출하려면 데이터가 다음 조건을 충족해야 합니다.

• 그라데이션: 연속적인 그라데이션이 없고 색상 간에 경계가 명확하게 정의된 이미지를 사용합니다.
• 색상: 바이너리(흑백)(권장)
• 해상도: 높음(단, 최적의 해상도는 모양의 복잡성과 인쇄 시 크기에 따라 달라질 수 있음에 유의하십
시오.)

인터넷을 통해 파일 공유

소재 모양이 포함된 이미지를 비트맵(BMP) 파일로 저장할 수 있습니다. 그런 다음 완성된 결과를 확인하
기 위해 인터넷을 통해 파일을 보낼 수 있습니다.

사진 이미지 최적화

사진 이미지의 색상을 기기에서 인쇄하기에 적합한 색상으로 자동 조정할 수 있습니다. 이 기능은 많은 
색상을 사용하는 사진 이미지에 효과적입니다.

가변데이터 각인 수행

각 시트에 각인 데이터의 일부를 변경한 후 다른 객체를 각인하는 것을 "가변 데이터 각인"이라고 합니다. 
우편 카드의 주소 인쇄와 유사하게, 내용을 변경하면서 데이터를 연속적으로 각인할 수 있습니다. 가변 데
이터 각인을 수행하려면 CSV 파일이 필요합니다. CSV 파일은 스프레드시트 소프트웨어 등을 사용하여 
만들 수 있습니다.

관련된 링크
・ P. 131 소프트웨어 도움말을 표시하는 방법
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일일 유지보수 시 주의 사항

가솔린, 알코올, 시너 또는 기타 가연성 물질을 절대로 사용하지 마십시오.
화재가 발생할 수 있습니다.

경고

인쇄가 끝난 후에는 절대로 헤드를 바로 만지지 마십시오.
화상을 입을 수 있습니다.

경고

• 이 기기는 정밀 기기이므로 먼지와 이물질에 민감합니다. 매일 청소를 하십시오.
• 희석제, 벤진 또는 알코올과 같은 용매를 사용하지 마십시오.
• 기기에 오일이나 윤활유를 바르려고 하지 마십시오.
• 기기에 실리콘 물질(오일, 그리스, 스프레이 등)을 바르지 마십시오. 그렇게 하면 스위치 접촉이 불량
    해질 수 있습니다.

접착 시트 청소

접착 시트에 먼지나 이물질이 쌓이면 접착력이 약해져 소재를 제자리에 고정하기 어려워질 수 있습니다. 먼
지나 이물질을 제거하지 않고 접착 시트를 사용하면 각인 중에 소재가 움직여 각인 품질이 저하될 수 있습니
다. 접착력이 약해진 경우 접착 시트를 청소하십시오.

청소 방법

접착 시트를 물에 담그고, 시트 표면을 가볍게 두드려 청소합니다. 접착 시트의 더러움이 심하면 희석된 중성 
세제를 사용하여 청소합니다. 물로 철저히 헹구어 세제를 완전히 제거합니다.

다음 지침을 반드시 준수하십시오. 준수하지 않으면 접착 시트 표면이 손상되어 접착력이 떨어질 수 있습니다.

• 수세미나 스폰지를 사용하여 접착 시트를 문지르지 마십시오.
• 청소 시 접착 시트를 늘리거나 구부리지 마십시오.

IMPORTANT

건조 방법
직사광선을 피하면서 시트를 완전히 건조시키십시오.

일일 유지보수
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본체 및 커버 청소

물에 적셔서 잘 짜낸 천을 사용하여 부품을 부드럽게 닦아서 청소하십시오. 커버 표면은 긁히기 쉽기 때문에 
부드러운 천을 사용하십시오.

헤드 캡 청소

기기에 장착된 헤드 캡을 분리하고 헤드 캡의 표면과 내부에서 먼지와 이물질을 제거합니다. 헤드 캡에서 먼
지와 이물질을 먼저 제거하지 않고 각인하면 소재가 손상되거나 각인 품질에 영향을 미칠 수 있습니다.

헤드를 받치고 손가락을 헤드 캡의 튀어나온 테두리에 놓으면 캡을 쉽게 분리할 수 있습니다.

MEMO
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마킹 핀 상태 확인

MPX-90 Head Manager가 마킹 핀 사용량을 표시하고 있습니다.
표시등이 빨간색으로 표시되면 헤드를 새 것으로 교체합니다. 표시등이 빨간색으로 표시되지 않더라도 각
인 품질이 만족스럽지 않거나 각인된 이미지의 불균일성이 지속되면 헤드를 새 것으로 교체합니다.

절차

1. MPX-90 Head Manager를 시작합니다.

• Windows 11
a. [시작]을 클릭합니다.
b. [모든 앱]>[MPX-90 Head Manager]를 클릭합니다.

• Windows 10
a. [시작]을 클릭합니다.
b. [MPX-90 Head Manager]>[MPX-90 Head Manager]를 클릭합니다.

• Windows 8.1

a. [시작] 화면 좌측 하단에 있는      을 클릭하면 [앱] 화면이 나타납니다.
b. [MPX-90 Head Manager]를 클릭합니다. 

MPX-90 Head Manager가 시작됩니다.

2. 기기의 전원을 켭니다.

P. 27 전원 켜기

이 창에는 마킹 핀 사용량이 표시됩니다. 레벨 표시기는 핀을 사용하여 소재를 타격함에 따
라 조금씩 증가합니다. 증가 속도는 각인되는 소재에 따라 다릅니다. 표시기가 읽기로 표시
되면 헤드를 교체할 때입니다.

최신 정보를 표시하도록 창이 새로 고쳐집니다.

관련된 링크

마킹 핀 조정하기
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・ P. 117 헤드 교체 방법
・ P. 125 각인 결과가 좋지 않은 경우
・ P. 126 이미지가 고르지 않는 경우

마킹 핀 조정하기
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마킹 핀의 타격력 조정

MPX-90 Head Manager를 사용하여 마킹 핀의 타격력을 조정할 수 있습니다. 마킹 핀 조정에는 그림에 표
시된 패턴을 타격하는 것이 포함됩니다.
기기와 함께 제공된 테스트용 인쇄 소재(황동 도금 판) 또는 크기가 최소 60 mm (2.37 in.) x 60 mm (2.37 
in.)인 다른 소재를 준비하십시오.

절차

1. MPX-90 Head Manager를 시작합니다.

• Windows 11
a. [시작]을 클릭합니다.
b. [모든 앱]>[MPX-90 Head Manager]을 클릭합니다.

• Windows 10
a. [시작]을 클릭합니다.
b. [MPX-90 Head Manager]>[MPX-90 Head Manager]를 클릭합니다.

• Windows 8.1

a. [시작] 화면 좌측 하단에 있는       을 클릭하면 [앱] 화면이 나타납니다.
b. [MPX-90 Head Manager]를 클릭합니다. 

MPX-90 Head Manager가 시작됩니다.

2. 기기의 전원을 켭니다.

P. 27 전원 켜기

3. [Readjust Pin]을 클릭합니다.

화면의 지시에 따라 마킹 핀을 조정하십시오.

마킹 핀 조정하기
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(1) 접착시트와 테이블을 이용해 소재를 고정합니다.

P. 42 기기에 소재 장착
(2) 헤드 캡을 사용하여 조정 패턴을 각인합니다.

조정 패턴이 각인되지 않으면 아래 섹션을 참조하십시오.
P. 123 각인된 위치가 원하는 위치가 아닌 경우
P. 124 타격이 수행되지만 아무것도 각인되지 않는 경우

4. 작업이 완료되면 MPX-90 Head Manager를 종료합니다.
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구성 등록 및 타격력 조정

여기서는 METAZA 드라이버에 구성을 등록하고 경도 및 기타 파라미터에 맞게 타격력을 조정합니다.
이 기기를 사용하면 사용된 소재의 구성에 적합한 타격력을 사용하여 각인하면 더욱 높은 품질의 각인 결과
를 얻을 수 있습니다. METAZA Driver에는 여러 구성과 해당 타격력에 대한 사전 설정이 있지만 이러한 구
성에 대한 최적의 타격력을 직접 등록할 수도 있습니다. 더 나은 각인 결과를 얻기 위해 직접 타격력을 등록
한 구성의 타격력을 나중에 조정할 수도 있습니다.

절차

1. 장치 및 프린터 목록을 표시합니다.

• Windows 11
a. [시작]>[모든 앱]>[Windows Tools]을 클릭합니다.
b. [제어판]을 클릭합니다.
c. [장치 및 프린터 보기]를 클릭합니다.

• Windows 10
a. [시작]>[Windows System]>[제어판]을 클릭합니다.
b. [장치 및 프린터 보기]를 클릭합니다.

• Windows 8.1
a. 화면 오른쪽 하단으로 포인터를 이동하여 참 바를 표시한 후 [설정]을 클릭합니다.
b. [제어판]을 클릭합니다.
c. [장치 및 프린터]를 클릭합니다.

2.  [Roland MPX-90]을 마우스 오른쪽 버튼으로 클릭합니다.

3. [프린터 속성]을 클릭합니다.

구성 등록 및 타격력 조정
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METAZA 드라이버 설정 창이 나타납니다.

4. [Image Correction] 탭을 클릭하고 다음 항목을 설정하십시오.

(1) [Material]을 사용하여 사용자 정의 소재를 선택하십시오.

사용자 정의 소재에 대해 설정 a부터 d까지 중 하나의 설정을 선택합니다.
(2) 각인 모드를 선택하십시오.

[Text] 텍스트 및 기타 이미지를 선명한 윤곽으로 각인하려는 경우

[Photo] 그라데이션으로 사진과 기타 이미지를 각인하려는 경우

[High Resolution] 작은 글씨나 작은 패턴을 선명하게 각인하고 싶은 경우

[Others] 이미지의 해상도 설정 및 기타 설정을 지정하려는 경우

(3) [Details]을 클릭합니다.

[Details] 창이 나타납니다.

5.  세부적인 타격력 설정을 구성합니다.

(1) 등록하려는 설정의 이름을 입력하십시오.

(2) 속도와 타격력을 입력합니다.
각인 결과는 소재의 경도에 따라 다릅니다. 사용하는 소재에 맞게 타격력을 조정하십시오.

(3) 고급 설정을 구성합니다.

[Advance] 항목은 각인 모드가 [Others]일 때만 설정할 수 있습니다.

구성 등록 및 타격력 조정
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(4) [OK]를 클릭합니다.

[Details] 창이 닫힙니다.

[Speed/Impact]

[Impact-MIN] 이미지에 대한 최소 각인 효과 값을 설정할 수 있습니다.
이미지의 어두운 부분이 희끄무레하거나 전체적인 인상이 너무 강렬한 경우에는 값을 낮추
십시오.

[Impact-MAX] 이미지에 대한 최대 각인 효과 값을 설정할 수 있습니다.
이미지의 밝은 부분을 너무 적은 힘으로 치는 경우 또는 전체적인 타격이 너무 약한 경우 
값을 높이십시오.
이미지의 밝은 부분이 너무 강하게 타격될 경우 값을 낮추십시오.

[Vector Impact] 라인에 대한 각인 영향의 최대값을 설정할 수 있습니다.

[Advance]

[Output Resolution] 인치당 도트 수를 지정할 수 있습니다.

[Drafting] 1도트 단위로 이미지 정보를 건너뛸 수 있습니다.

구성 및 타격 값(참조 값)

구성 [Impact-MIN] [Impact-MAX]

황동 또는 구리 200 350 - 450

철 또는 스테인리스 스틸 200 400 - 500

티타늄 200 500 - 600

타격력이 너무 강하면 소재 표면의 페인트가 벗겨질 수 있습니다. 페인트가 벗겨지면 기기 오작동
이 발생할 수 있습니다. 각인 중에 페인트가 벗겨지는 것을 방지하기 위해 타격 값을 조정하십시
오.

6. [OK]를 클릭합니다.

설정이 저장되고 [인쇄 기본 설정] 창이 닫힙니다.
더 높은 품질의 각인 결과를 얻으려면 동일한 소재에 테스트 각인을 수행하거나 오버스트라이킹을 
수행한 후 각인 결과에 따라 타격 값을 조정합니다.

구성 등록 및 타격력 조정
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기기 원점 위치 조정

기기의 원점을 테이블의 그리드 중앙에 설정합니다. 교정 데이터를 각인하여 원점을 확인할 수 있습니다. 
원점이 변경된 경우 다음 절차를 사용하여 원점을 조정합니다.
원점을 조정하려면 크기가 최소 20 mm × 20 mm (0.79 in. × 0.79 in.)인 판재 모양의 소재를 사용하십
시오.

교정 데이터 각인

절차

1. 기기의 전원을 켭니다.

기기가 초기동작를 실행하고 전원/이동 버튼의 램프가 켜집니다.
P. 27 전원 켜기

2. 소재를 장착합니다.
원점 조정 시에는 반드시 헤드 캡을 장착하고 접착시트와 함께 사용하여 소재를 장착 합니다.

P. 42 소재 장착

3. METAZAStudio를 시작합니다.

4. 교정 데이터를 엽니다.

(1)    를 클릭합니다.

(2) METAZAStudio가 설치된 폴더에서 [Samples] 폴더를 엽니다.

(3) [Axis.mzs]를 선택하고 [Open]을 클릭합니다.

원점 조정
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5.     를 클릭합니다.

교정 데이터의 각인이 시작됩니다.

관련된 링크
・ P. 59 각인 시작

원점 조정
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원점의 변경 측정 및 보정값 입력

절차

1. 테이블 그리드 ①의 중심 선과 소재 ②의 교차선 사이의 오프셋을 측정하여 기록해 둡니다.

다음 그림에 표시된 예에서 원점은 [폭] 방향으로 +0.3 mm (+0.01 in.)만큼 변경되고(A), [길이]
방향으로 -0.5 mm (-0.02 in.)만큼 변경되었습니다(B).

2. 장치 및 프린터 목록을 표시합니다.

• Windows 11
a. [시작]>[모든 앱]>[Windows Tools]을 클릭합니다.
b. [제어판]을 클릭합니다.
c. [장치 및 프린터 보기]를 클릭합니다.

• Windows 10
a. [시작]>[Windows System]>[제어판]을 클릭합니다.
b. [장치 및 프린터 보기]를 클릭합니다.

• Windows 8.1
a. 화면 오른쪽 하단으로 포인터를 이동하여 참 바를 표시한 후 [설정]을 클릭합니다.
b. [제어판]을 클릭합니다.
c. [장치 및 프린터]를 클릭합니다.

3. [Roland MPX-90]을 마우스 오른쪽 버튼으로 클릭합니다.

원점 조정
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4. [프린터 속성]을 클릭합니다.

METAZA 드라이버 설정 창이 나타납니다.

5. 원점을 조정합니다.

(1) [Material] 탭을 클릭합니다.

(2) [Offset]에서 1단계에서 기록한 [Width] 및 [Length]의 변경 값을 입력합니다. 

1단계의 그림의 경우 [Width]에 0.3을 입력하고 [Length]에 -0.5를 입력합니다.
(3) [OK]를 클릭합니다.

설정이 저장되고 [인쇄 기본 설정] 창이 닫힙니다.

원점 조정
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METAZAStudio용 METAZA 드라이버 설정 창이 표시되면, 적용된 모든 설정 값은 임시적이며 저장되지 않습니
다.
METAZAStudio를 닫은 후에도 원점을 보정하려면 Windows 프린터 설정에서 METAZA 드라이버를 열고 조정
해야 합니다.

MEMO

관련된 링크
・ P. 98  METAZA 드라이버 설정 유지

원점 조정
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헤드 캡 교체 주기

아래 그림과 같이 헤드 캡이 마모되면 교체할 때입니다. 필요에 따라 헤드 캡을 새 것으로 교체하십시오.
마모 정도는 각인 조건에 따라 다릅니다. 특히 알루미늄 소재 등에 선이 많은 각인(Island Fill, etc.)을 할 
경우 소재 표면의 요철이 커져 헤드 캡이 더 빨리 마모됩니다. 헤드 캡의 상태를 주기적으로 확인하여 필요
에 따라 교체하십시오.

관련된 링크
・ P. 42 소재 장착

헤드 캡 교체
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헤드 교체 주기

MPX-90 Head Manager는 마킹핀 사용량을 표시합니다.
사용하는 핀의 표시가 빨간색이면 새 헤드로 교체합니다. 좋은 품질로 각인이 불가능하거나 각인이 된 이
미지가 빨간색이 아니어도 고르지 않으면 새 헤드로 교체합니다.

헤드 수명의 일반적인 가이드
다음과 같은 조건에서는 약 4,000개의 판을 인쇄할 수 있습니다.

• 사용 소재: MD-NI(Roland 니켈 도금 판)
• 각인 영역: 30 mm × 23 mm (1.18 in. × 0.91 in.)
• 각인 모드: 사진
• 각인 속도: 35 % (판당 25,000도트)

관련된 링크
・ P. 103 마킹 핀 상태 확인
・ P. 125 각인 결과가 좋지 않은 경우
・ P. 126 이미지가 고르지 않는 경우

헤드 교체
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헤드 교체 방법

MPX-90 Head Manager는 헤드 교체 작업에 사용됩니다.
헤드 교체 작업 중에 그림에 표시된 패턴이 타격됩니다. 교체용 헤드(MPH-90)와 함께 제공된 테스트용 각
인 소재(황동 도금 판) 또는 최소 60 mm (2.37 in.) x 60 mm (2.37 in.) 크기의 다른 소재를 준비합니다.
교체용 헤드는 별도로 판매됩니다. 공인 Roland DG Corporation 딜러에게 문의하십시오.

• 교체 작업을 중간에 멈추지 마십시오.
• 마킹 핀이 마모된 경우 헤드를 사용하지 마십시오.
• 기기에서 분리된 헤드를 사용하지 마십시오.

IMPORTANT

절차

1. MPX-90 Head Manager를 시작합니다.

• Windows 11
a. [시작]을 클릭합니다.
b. [모든 앱]>[MPX-90 Head Manager]을 클릭합니다.

• Windows 10
a. [시작]을 클릭합니다.
b. [MPX-90 Head Manager]>[MPX-90 Head Manager]를 클릭합니다.

• Windows 8.1

a. [시작] 화면 좌측 하단에 있는       을 클릭하면 [앱] 화면이 나타납니다.
b. [MPX-90 Head Manager]를 클릭합니다. 

MPX-90 Head Manager가 시작됩니다.

2. 기기의 전원을 켭니다.

P. 27 전원 켜기

3. [Replace Head]를 클릭합니다.

화면의 지시에 따라 핀 조정을 수행합니다.

헤드 교체
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헤드 캡을 사용하여 조정 패턴을 각인합니다.
                        P. 42 기기에 소재 장착
조정 패턴이 인쇄되지 않으면 아래 섹션을 참조하십시오.

P. 123 각인된 위치가 원하는 위치가 아닌 경우
P. 124 타격이 수행되지만 아무것도 각인되지 않는 경우

4. 작업이 완료되면 MPX-90 Head Manager를 종료합니다.

헤드 교체

118 유지보수 및 조정
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전원 공급 장치 표시등이 점멸하는 경우

헤드 위치가 설정된 상태에서 전원을 켜시나요?

헤드 위치가 설정된 상태에서 전원을 켜면 초기 동작이 완료된 직후 전원 표시등이 깜빡입니다.
헤드가 소재의 표면 높이와 관련하여 부적절한 위치에 설정된 경우 소재 표면이 긁힐 수 있고/또는 마킹 핀
이 손상될 수 있습니다. 이러한 오류가 발생하지 않도록 전원 공급 장치 표시등이 깜박입니다.

절차

1. 노브를 시계 반대 방향으로 한 번 풀어줍니다.

헤드 위치 설정이 초기화됩니다.

2. 노브를 조입니다.

3. 전원/이동 버튼을 누릅니다.

오류가 해결되고 전원 표시등이 켜집니다.

헤드 캡을 사용하지 않는 경우, 소재의 표면 높이에 따라 헤드 위치를 조정하시나요?

전원을 끄십시오. 각인이 진행 중이면 중지합니다.
헤드 캡을 사용하지 않고 각인을 수행하는 경우 헤드 위치가 소재의 표면 높이보다 낮으면 헤드 끝이 소재 
표면에 접촉하고 전원 공급 표시등이 깜박입니다. 소재의 표면 높이를 기준으로 헤드 위치를 적절한 위치로 
조정하고 노브로 헤드를 단단히 고정합니다.

관련된 링크

・ P. 29 전원 끄기
・ P. 42 소재 장착
・ P. 62 기기에서 각인 중지

전원을 켤 때 헤드를 들어올리시나요?

전원을 끄십시오.
헤드를 최상단까지 들어올리면 기기는 소재의 표면 높이가 각인 조건을 벗어났다는 것을 인식하고 전원 공
급 표시등이 깜박입니다. 반드시 사용자 설명서에 따라 기기를 다루십시오.

관련된 링크
・ P. 29 전원 끄기

각인 표면의 높이 변화가 너무 큰가요?
각인을 중지합니다.

문제 해결
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각인 표면 높이의 변화가 너무 크면 전원 공급 표시등이 깜박입니다. 각인 가능한 소재의 상태를 확인하
고 소재를 다시 선택하십시오.

관련된 링크
・ P. 23 기기가 각인할 수 있는 소재
・ P. 62 기기에서 각인 중지

제공된 테이블, 센터 바이스 또는 클램프 핀을 사용하지 않고 소재를 장착했습니까?

전원을 끄십시오. 각인이 진행 중이면 중지하십시오.
제공된 테이블, 센터 바이스 또는 클램프 핀을 사용하지 않고 표면 높이가 낮은 소재를 장착하면 기기는 소재
의 표면 높이가 각인 가능한 소재의 조건을 벗어났다고 인식하고 전원 공급 표시등이 깜박입니다. 제공된 테
이블(또는 센터 바이스)을 사용하여 소재를 장착해야 합니다.

관련된 링크
・ P. 29 전원 끄기
・ P. 42 소재 장착
・ P. 62 기기에서 각인 중지

노브가 느슨해졌나요?

각인을 중지합니다.
헤드 캡을 사용하지 않을 경우 노브가 느슨해지면 헤드 위치가 소재의 표면 높이와 일치하지 않아 전원 공급 
표시등이 깜빡입니다. 헤드 위치를 설정할 때는 노브를 단단히 조이십시오.

관련된 링크
・ P. 42 소재 장착
・ P. 62 기기에서 각인 중지

초기 동작 오류가 발생했나요?
헤드의 스토퍼를 풀고 전원/이동 버튼을 누릅니다. 오류가 지워지고 전원 램프가 켜집니다.

관련된 링크
・ P. 27 전원 켜기

문제 해결
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각인 데이터를 전송해도 기기가 작동하지 않는 경우

전원이 켜져 있나요?
전원/이동 버튼 표시등이 켜져 있는지 확인하십시오. 꺼져 있으면 전원을 켜십시오.

관련된 링크
・ P. 27 전원 켜기

전원 코드가 올바르게 연결되어 있나요?
올바르게 연결되지 않은 경우 아래 설명을 참조하여 올바르게 연결하십시오.

관련된 링크
・ P. 13 케이블 연결

컴퓨터 연결에 사용된 케이블이 올바르게 연결되어 있나요?
연결 케이블이 분리되어 있는지 확인하십시오.

문제 해결
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각인된 위치가 원하는 위치가 아닌 경우

소재가 올바른 위치에 장착되어 있습니까?
소재가 올바른 위치에서 벗어난 위치에 장착되면 올바른 위치에 각인할 수 없습니다. 소재를 다시 장착합니
다.

관련된 링크
・ P. 42 소재 장착

기기의 원점이 변경되었습니까?
테이블 그리드의 중심은 기기의 각인 원점과 일치하지 않을 수 있습니다. 기기의 원점을 테이블 그리드의 
중심으로 설정합니다. 원점을 확인하려면 교정 데이터를 인쇄합니다. 원점이 변경된 경우 원점을 조정합니
다.

관련된 링크
・ P. 110 기기 원점 위치 조정

문제 해결
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타격이 수행되지만 아무것도 각인되지 않는 경우

각인할 소재가 각인 가능한 소재의 매개변수와 일치합니까?

각인 가능한 소재를 준비하고 사용합니다.

관련된 링크
・ P. 23 기기가 각인할 수 있는 소재

헤드 캡을 사용하지 않는 경우, 헤드 위치가 소재의 표면 높이와 일치합니까?

헤드 캡을 사용하지 않는 경우 헤드 위치가 소재의 표면 높이와 일치하는지 확인하십시오. 헤드 위치가 소재
의 높이 위치와 일치하지 않으면 각인을 수행할 수 없습니다. 헤드 위치를 조정한 다음 노브를 단단히 조입
니다.

관련된 링크
・ P. 42 소재 장착

마킹핀이 구부러지거나 부러졌습니까?
아무것도 각인되지 않고 소재가 장착되는 위치, 소재의 매개변수 또는 헤드 유닛의 높이를 변경해도 문제가 
해결되지 않으면 마킹 핀이 구부러지거나 부러졌을 수 있습니다. 사용하지 않은 마킹 핀으로 변경하고 테스
트 마킹을 수행해 보십시오. 새 마킹 핀으로 각인할 수 있다면 사용하던 마킹 핀이 구부러지거나 부러졌다는 
의미입니다. 새 마킹 핀을 계속 사용하십시오.

관련된 링크
・ P. 117 헤드 교체

문제 해결
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각인 결과가 좋지 않은 경우

드라이버 설정창의 소재 설정이 정확합니까?

장착된 소재의 구성을 선택합니다.
소재의 구성이 동일하더라도 주조 방법, 불순물 구성, 도금 유무 등에 따라 각인 표면의 경도가 크게 달라질 
수 있습니다. 이러한 경우 소재에 맞게 타격력을 미세 조정하십시오.

관련된 링크
・ P. 107 구성 등록 및 타격력 조정

이미지가 선명하게 인쇄되었나요?

이미지가 선명하게 각인되지 않으면 이미지의 밝기를 조정합니다. 미리보기 창에서 [Gamma] 또는 
[Brightness] 값을 조금씩 변경하면서 각인을 수행하여 밝기를 높입니다. 이때 소재를 장착한 상태로 두고 
동일한 위치에서 오버스트라이킹을 수행합니다. 원하는 어두움을 얻을 때까지 설정을 계속 변경하고 인쇄
를 수행합니다.

관련된 링크
・ P. 88 미리보기 창에서 완성된 결과 확인

회색조 톤이 선명하게 인쇄됩니까?

회색조 톤이 불분명한 경우 METAZA 드라이버의 [Image Correction] 탭으로 이동하여 [Details]를 사용하
여 타격 강도를 조정합니다. [Impact-MAX] 값은 변경하지 않고 [Impact-MIN] 값을 조금씩 높이면서 각인
을 수행합니다. 이때 소재를 장착한 상태로 두고 같은 위치에서 오버스트라이킹을 수행합니다. METAZA 드
라이버 설정 창에서 설정을 계속 변경하고 원하는 어두움을 얻을 때까지 각인을 수행합니다.

관련된 링크
・ P. 107 구성 등록 및 타격력 조정

오버스트라이킹에 대한 추가 정보

오버스트라이킹으로 결정된 다양한 설정 값은 동일한 조건에서 오버스트라이킹을 수행할 때만 효과적입
니다. 오버스트라이킹을 수행하지 않고 조건만 동일하게 한 새로운 소재로 각인을 수행하면 반드시 동일
한 결과가 얻어지는 것은 아닙니다.

마킹핀이 마모되었습니까?

마킹 핀이 마모되면 좋은 품질의 각인이 불가능할 수 있습니다. 마킹 핀의 상태를 확인하십시오. 마킹 핀이 
마모되면 헤드를 새 것으로 교체하십시오.

관련된 링크
・ P. 103 마킹 핀 상태 확인
・ P. 117 헤드 교체 방법

문제 해결
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이미지가 고르지 않는 경우

각인 표면이 고르지 않습니까?

헤드 캡이 장착되지 않은 경우 헤드 캡을 장착하고 각인을 수행합니다. 헤드 캡이 장착된 상태에서 각인으로 
인해 손상될 수 있는 소재를 사용하는 경우 각인 표면이 평평한 소재로 교체합니다.

관련된 링크
・ P. 22 헤드 캡
・ P. 23 기기가 각인할 수 있는 소재

각인 표면이 비스듬하게 되어 있나요?

헤드 캡이 장착되지 않은 경우 헤드 캡을 장착하고 각인을 수행합니다. 헤드 캡이 장착된 상태에서 각인으로 
인해 손상될 수 있는 소재를 사용하는 경우 각인 표면이 평평한 소재로 교체합니다.

관련된 링크

이미지의 암부가 고르지 않습니까?

동일한 위치에 장착된 상태로 오버스트라이킹을 수행하면 이미지 품질이 향상될 수 있습니다. 미리 보기 창
에서 [Gamma], [Brightness] 또는 [Contrast]에 대해 다른 설정으로 오버스트라이킹을 수행해 보십시오.

관련된 링크
・ P. 88 미리보기 창에서 완성된 결과 확인

양방향 각인이 수행되었습니까?

양방향 각인은 각인 시간을 단축할 수 있지만 이미지 품질이 떨어질 수 있습니다. 이런 경우 METAZA 드라
이버 설정 창으로 가서 [Bidirection]에 대한 선택을 취소하고 각인을 다시 실행하십시오.

관련된 링크
・ P. 130 METAZA 드라이버 온라인 도움말 표시

마킹 핀이 마모되었습니까?

마킹 핀이 마모되면 좋은 품질의 각인이 불가능할 수 있습니다. 마킹 핀의 상태를 확인하십시오. 마킹 핀이 
마모되면 헤드를 새 것으로 교체하십시오.

관련된 링크
・ P. 103 마킹 핀 상태 확인
・ P. 117 헤드 교체 방법

문제 해결
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특정 같은 부위의 각인이 항상 희미한 경우

각인 표면의 높이 변화가 너무 큰가요?

헤드 캡을 사용하여 각인을 수행하더라도 항상 동일한 부분에서 각인이 희미한 경우 각인 표면에 과도한 
높이 변화가 있을 수 있습니다. 기기가 각인할 수 있는 소재의 매개변수를 다시 확인하고 매개변수를 충족
하는 소재를 선택하십시오. 또한 이 기기로 곡면에 사진 데이터를 각인할 때 이미지 품질이 보장되지 않습
니다.

관련된 링크
・ P. 23 기기가 각인할 수 있는 소재

기기의 수평을 조정해 보셨나요?

테이블의 전면 오른쪽 모서리 근처와 같이 동일한 위치에서 이미지가 자주 희미해지는 경우 기기가 수평이 
아닌 위치에 설치된 것일 수 있습니다. 기기의 수평을 조정하면 이미지 품질이 향상될 수 있습니다.
이미지의 불균일성이 각인 위치와 관련이 없는 경우, 예를 들어 불균일한 부분이 소재나 이미지마다 다른 
경우 이 방법이 효과적이지 않습니다. 가능한 경우 헤드 캡을 사용하는 것이 좋습니다.

절차

1. 접착 시트를 사용하여, 제공된 테스트용 각인 소재 한 조각을 테이블 중앙에 놓습니다.
제공된 소재를 모두 사용한 경우, 다음 조건을 충족하는 소재를 준비한 후, 헤드 캡을 사용하지 않
고 각인해 주십시오.
• 60 mm x 60 mm (2.37 in. x 2.37 in.)보다 큰 크기
• 평활도 0.05 mm (1.96 mil) 이하

2. 장치 및 프린터 목록을 표시합니다.

• Windows 11
a. [시작]>[모든 앱]>[Windows Tools]을 클릭합니다.
b. [제어판]을 클릭합니다.
c. [장치 및 프린터 보기]를 클릭합니다.

• Windows 10
a. [시작]>[Windows System]>[제어판]을 클릭합니다.
b. [장치 및 프린터 보기]를 클릭합니다.

• Windows 8.1
a. 화면 오른쪽 하단으로 포인터를 이동하여 참 바를 표시한 후 [설정]을 클릭합니다.
b. [제어판]을 클릭합니다.
c. [장치 및 프린터]를 클릭합니다.

3. [Roland MPX-90]을 마우스 오른쪽 버튼으로 클릭합니다.

문제 해결
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4. [프린터 속성]을 클릭합니다.

METAZA 드라이버 설정 창이 나타납니다.

5. 테스트 패턴을 인쇄합니다.

(1) [Option] 탭을 클릭합니다.

(2) [Test print]를 클릭합니다.

테스트 패턴은 소재에 각인됩니다.

문제 해결

128 부록



6. 그리드를 사용하여 테스트 패턴이 연속적이지 않거나 보이지 않는 위치를 읽고 기록하십시오.

네 방향(앞, 뒤, 왼쪽, 오른쪽) 모두의 값을 기록해 둡니다.

7. 수평을 조절합니다.

(1) [Correct slope] 확인란을 선택합니다.

(2) 기록한 그리드 값을 드라이버에 입력합니다.

(3) [OK]를 클릭합니다.

관련된 링크
・ P. 22 헤드 캡

문제 해결
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METAZA 드라이버와 소프트웨어 사용 방법을 이해하지 못하는 경우

METAZA 드라이버 온라인 도움말 표시

METAZA 드라이버를 설치한 후 다음 절차에 따라 온라인 도움말을 표시할 수 있습니다. 

절차

1. 장치 및 프린터 목록을 표시합니다.

• Windows 11

a. [시작]>[모든 앱]>[Windows Tools]을 클릭합니다.
b. [제어판]을 클릭합니다.
c. [장치 및 프린터 보기]를 클릭합니다.

• Windows 10

a. [시작]>[Windows System]>[제어판]을 클릭합니다.
b. [장치 및 프린터 보기]를 클릭합니다.

• Windows 8.1

a. 화면 오른쪽 하단으로 포인터를 이동하여 참 바를 표시한 후 [설정]을 클릭합니다.
b. [제어판]을 클릭합니다.
c. [장치 및 프린터]를 클릭합니다.

2. [Roland MPX-90]을 마우스 오른쪽 버튼으로 클릭합니다.

3. [프린터 속성]을 클릭합니다.

문제 해결
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METAZA 드라이버 설정 창이 나타납니다.

4. [Help]를 클릭합니다.

METAZA 드라이버 온라인 도움말이 나타납니다.

관련된 링크
・ P. 16 METAZA 드라이버 설치

소프트웨어 도움말을 표시하는 방법

소프트웨어를 설치한 후 다음 절차에 따라 온라인 도움말을 볼 수 있습니다. 

절차

1. [시작] 메뉴를 클릭합니다.

2. 소프트웨어를 선택한 후 [Help]를 클릭하십시오.

관련된 링크
・ P. 17 소프트웨어 설치

문제 해결
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METAZA 드라이버 설치가 불가능한 경우

설치가 중간에 중단되거나 USB 케이블로 연결했을 때 마법사가 나타나지 않는 경우, 다음 절차에 따라 
METAZA 드라이버를 다시 설치하십시오.

Windows 11에 드라이버 설치

절차

1. USB 케이블을 사용하여 기기와 컴퓨터를 연결한 후 기기를 켭니다.

2. [새 하드웨어 발견]이 나타나면 [취소]를 클릭하여 닫습니다.

이 기기 이외의 프린터용 USB 케이블을 모두 분리합니다.

3. [데스크톱]을 클릭합니다.

4. [시작] 버튼을 마우스 오른쪽 버튼으로 클릭한 후 [장치 관리자]를 클릭합니다.

5. [사용자 계정 컨트롤] 창이 나타나면 [계속]을 클릭합니다.

[장치 관리자]가 나타납니다.

6. [보기] 메뉴에서 [숨겨진 장치 표시]를 클릭합니다.

7. 목록에서 [프린터] 또는 [기타 장치]를 찾아 더블 클릭합니다.

선택한 항목 아래에 나타나는 모델 이름이나 [알 수 없는 장치]를 클릭하십시오.

8. [작업] 메뉴에서 [제거]를 클릭합니다.

9. [장치 제거 확인] 창에서 [확인]을 클릭합니다. [장치 관리자]가 닫힙니다.

10. 컴퓨터에서 USB 케이블을 분리하고 컴퓨터를 다시 시작합니다.

11. METAZA 드라이버를 제거하십시오.

P. 134 METAZA 드라이버 제거

12. METAZA 드라이버 설치 절차를 처음부터 다시 수행하십시오.

P. 16 METAZA 드라이버 설치

문제 해결
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Windows 10 또는 8.1에 드라이버 설치

절차

1. USB 케이블을 사용하여 기기와 컴퓨터를 연결한 후 기기를 켭니다.

2. [새 하드웨어 발견]이 나타나면 [취소]를 클릭하여 닫습니다.

이 기기 이외의 프린터에 대한 USB 케이블을 모두 분리하십시오.

3. [데스크톱]을 클릭합니다.

4. [시작] 버튼을 마우스 오른쪽 버튼으로 클릭하여 [장치 관리자]를 클릭합니다.

5. [사용자 계정 컨트롤] 창이 나타나면 [계속]을 클릭합니다.

[장치 관리자]가 나타납니다.

6. [보기] 메뉴에서 [숨겨진 장치 표시]를 클릭합니다.

7. 목록에서 [프린터] 또는 [기타 장치]를 찾아 더블클릭합니다.

선택한 항목 아래에 나타나는 모델 이름이나 [알 수 없는 장치]를 클릭하십시오.

8. [작업] 메뉴에서 [제거]를 클릭합니다.

9. [장치 제거 확인] 창에서 [확인]을 클릭합니다. [장치 관리자]가 닫힙니다.

10. 컴퓨터에서 USB 케이블을 분리하고 컴퓨터를 다시 시작합니다.

11. METAZA 드라이버를 제거하십시오.

P. 134 METAZA 드라이버 제거

12. METAZA 드라이버 설치 절차를 처음부터 다시 수행하십시오.

P. 16 METAZA 드라이버 설치

문제 해결
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METAZA 드라이버 제거

METAZA 드라이버를 제거하려면 다음 절차를 따르십시오.

Windows 11에서 드라이버 제거

절차

1. 기기의 전원을 끄고 기기와 컴퓨터 사이의 USB 케이블을 분리합니다.

2. [관리자] 권한으로 Windows에 로그온합니다.

3. [시작]>[모든 앱]>[Windows Tools]을 클릭합니다.

4. [제어판]을 클릭합니다.

5. [프로그램 제거]를 클릭합니다.

6. 삭제할 기기의 드라이버를 클릭하여 선택고 [제거]를 클릭합니다.

[사용자 계정 컨트롤] 창이 나타나면 [허용]을 클릭합니다.

7. 삭제 확인 메시지가 나타납니다. [예]를 클릭합니다.

8. [시작]>[데스크톱]을 클릭합니다.

9. 탐색기를 열고 드라이버가 들어 있는 드라이브와 폴더를 엽니다.
다음 URL에 접속하여 삭제하려는 기기의 드라이버를 다운로드한 후, 다운로드한 파일을 압축 해제
할 폴더를 지정하십시오.
https://downloadcenter.rolanddg.com/MPX-90S#software

10. [SETUP.EXE]를 더블 클릭합니다.

11. [사용자 계정 컨트롤] 창이 나타나면 [허용]을 클릭합니다.

드라이버 설치 프로그램이 시작됩니다.

12. [제거]를 클릭합니다.

제거할 기기를 선택하고 [시작]을 클릭합니다.

13. 컴퓨터를 재시작해야 하는 경우 재시작 여부를 묻는 창이 나타납니다. [예]를 클릭하십시오.

14. 컴퓨터가 재시작되면 제어판을 다시 열고 [장치 및 프린터 보기] 또는 [장치 및 프린터]를 클릭합니다.

15. 제거하고자 하는 기기의 아이콘이 보인다면, 해당 기기를 마우스 오른쪽 버튼으로 클릭하여 [장치 제거]를 클릭
합니다.

관련된 링크
・ https://www.rolanddg.kr/

문제 해결
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Windows 10 또는 8.1에서 드라이버 제거

절차

1. 기기의 전원을 끄고, 기기와 컴퓨터 사이의 커넥터 케이블을 분리하십시오.

2. [관리자] 권한으로 Windows에 로그온합니다.

3. [데스크톱]을 클릭합니다.

4. [시작] 버튼을 마우스 오른쪽 버튼으로 클릭하고 [제어판]을 클릭합니다.

5. [프로그램 제거] 또는 [프로그램 및 기능]을 클릭하십시오.

6. 삭제할 기기의 드라이버를 클릭하여 선택하고 [제거]를 클릭합니다.

[사용자 계정 컨트롤] 창이 나타나면 [허용]을 클릭합니다.

7. 삭제 확인 메시지가 나타납니다. [예]를 클릭합니다.

8. [시작]>[데스크톱]을 클릭합니다.

9. 탐색기를 열고 드라이버가 들어 있는 드라이브와 폴더를 엽니다.
다음 URL에 접속하여 삭제하려는 기기의 드라이버를 다운로드한 후, 다운로드한 파일을 압축 해제
할 폴더를 지정하십시오.
https://www.rolanddg.kr/

10. [SETUP.EXE]를 더블 클릭합니다.

11. [사용자 계정 컨트롤] 창이 나타나면 [허용]을 클릭합니다.

드라이버 설치 프로그램이 시작됩니다.

12. [제거]를 클릭합니다.

제거할 기기를 선택하고 [시작]을 클릭하십시오.

13. 컴퓨터를 재시작해야 하는 경우 재시작 여부를 묻는 창이 나타납니다. [예]를 클릭합니다.

14. 컴퓨터가 재시작되면 제어판을 다시 열고 [장치 및 프린터 보기] 또는 [장치 및 프린터]를 클릭합니다.

15. 제거하고자 하는 기기의 아이콘이 보인다면, 해당 기기를 마우스 오른쪽 버튼으로 클릭하여 [장치 제거]를 클릭
하십시오.

문제 해결
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기기에 리테이너 장착

기기를 이동할 때에는 반드시 리테이너를 장착하십시오. 설치 중에 기기 뒷면에 장착된 리테이너를 제거한 
후 다음 절차에 따라 장착하십시오. 리테이너를 장착하지 않고 기기를 이동하면 기기가 손상될 수 있습니다.

절차

1. 기기의 전원을 켭니다.

P. 27 전원 켜기

2. 테이블, 센터 바이스 또는 클램프 핀을 제거합니다.

3. 헤드의 끝부분에 헤드 캡을 장착합니다.

4. 전원을 끕니다.

5. 전원/이동 버튼을 1초 이상 길게 누릅니다.

다음 그림과 같이 헤드가 움직입니다.

기기 이동
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6. 노브를 느슨하게 합니다.

7. 헤드를 들어올리면서 노브를 조입니다.

8. 케이블을 분리합니다.

기기 이동
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9. 리테이너를 장착합니다.

리테이너를 3곳에 5개의 스크류로 고정합니다. 모든 리테이너를 장착하고 제공된 육각 렌치로 
스크류를 조입니다.

10. 커버를 닫습니다.

11. 기기를 원래 포장에 다시 포장하십시오.

관련된 링크
・ P. 11 리테이너 보관

기기 이동
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・ P. 27 전원 켜기 및 끄기

기기 이동
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본체 주요 사양

MPX-90S

각인 가능한 소재 금, 은, 구리, 백금, 황동, 알루미늄, 철, 스테인레스 등 *1

장착 가능한 소재 크기
(너비) × (길이) × (두께)

최대 100 mm × 200 mm × 40 mm 
(3.93 in. × 7.87 in. × 1.57 in.)

각인 영역 최대 80 mm × 80 mm (3.14 in. × 3.14 in.)

해상도 High Resolution 529 dpi

Photo 353 dpi

Text 265 dpi

Vector 1058 dpi

각인 방향 단방향 각인 또는 양방향 각인 *2

각인 속도 
(기본값)

High Resolution 33 mm/s

Photo 50 mm/s

Text 33 mm/s

Vector 24 mm/s

인터페이스 USB

전력 요구 사항

전용 AC 어댑터 입력 100 - 240 VAC, 50/60 Hz

출력 19 VDC, 2.1 A

정격 전류 1.6 A

전력 소비 약 24 W

작동 소음 70 dB (A) 이하

작동 환경 온도: 10 - 30 ℃ (50 - 86 ℉), 습도: 35 - 80 %RH (결로 없을 것)

외형 치수 
(너비) × (깊이) × (높이)

286 mm × 383 mm × 308 mm 
(11.26 in. × 15.08 in. × 12.13 in.)

중량 10.8 kg (23.81 lb.)

기본 제공 품목 AC 어댑터, 전원 코드, 테스트 용 소재, USB 케이블, 안전 주의사항 등

*1 인쇄면의 비커스 경도[HV]는 200 이하여야 합니다.
*2 Windows 드라이버로 선택 가능

USB 연결을 위한 시스템 요구 사항

MPX-90S

컴퓨터 Windows 11, 10, 8.1 (32비트 또는 64비트)이 사전 설치된 모델 또는 원래 Windows 
8.1 이상이 사전 설치된 업그레이드된 컴퓨터

USB 케이블 제공된 USB 케이블을 사용하십시오.

사양

140 부록
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